DTS 8 Monaco

Softing
Automotive Electronics GmbH
Richard-Reitzner-Allee 6
85540 Haar / Germany
T +49 89 456 56-420
F +49 89 456 56-399

info.automotive@softing.com
www.softing.com
# Contents

1 Overview 9

2 Starting Monaco 10

3 Working in Execution Mode 13
   3.1 The User Interface In Execution Mode ........................................... 14
      3.1.1 The Monaco Menu Bar in Execution Mode .............................. 15
         3.1.1.1 File Menu ......................................................................... 16
         3.1.1.2 Edit Menu ......................................................................... 18
         3.1.1.3 View Menu ......................................................................... 18
         3.1.1.4 Execution Menu ................................................................. 20
         3.1.1.5 Tools Menu .......................................................................... 22
         3.1.1.6 Help Menu .......................................................................... 24
      3.1.2 The Monaco Toolbar in Execution Mode ..................................... 25
      3.1.3 Service Tree ........................................................................... 26
         3.1.3.1 User Interface ..................................................................... 27
         3.1.3.2 Configurator ....................................................................... 29
         3.1.3.3 Common Settings ............................................................... 30
         3.1.3.4 Filters ................................................................................ 31
      3.1.4 Status Message Area ................................................................. 33
   3.2 Opening a workspace ...................................................................... 34
   3.3 Starting and Stopping the Execution ................................................ 36
   3.4 Starting and Stopping the Instruments ............................................. 37
   3.5 Global Protocol Parameter Settings ................................................. 38

4 Working in Configuration Mode 40
   4.1 The User Interface In Configuration Mode ...................................... 41
      4.1.1 The Monaco Menu Bar in Configuration Mode ......................... 43
         4.1.1.1 File Menu .......................................................................... 43
         4.1.1.2 Edit Menu .......................................................................... 45
         4.1.1.3 View Menu .......................................................................... 45
         4.1.1.4 Configuration Menu ............................................................ 47
         4.1.1.5 Tools Menu .......................................................................... 52
         4.1.1.6 Help Menu .......................................................................... 54
      4.1.2 The Monaco Toolbar in Configuration Mode ............................... 55
      4.1.3 Configuration Bar ..................................................................... 56
      4.1.4 Property Sheet ........................................................................ 59
   4.2 Creating a new Workspace ............................................................... 61
   4.3 Creating a new Workspace Template ............................................... 63
   4.4 Setting Up Layouts ....................................................................... 64
4.5 Setting up HMI Controls ................................................................. 67
  4.5.1 Adding an HMI Control to a Layout ........................................ 68
  4.5.2 Selecting an HMI Control ..................................................... 70
  4.5.3 Configuration of HMI Controls ............................................ 71
  4.5.4 Arranging HMI Controls ..................................................... 72
  4.5.5 Duplicating and Moving HMI Controls ................................. 73
  4.5.6 Changing the HMI Control Sequence Order ......................... 73
  4.5.7 Deleting an HMI Control ................................................... 74

5 Working with HMI Controls ............................................................ 74
  5.1 Logical Link States .................................................................. 74
  5.2 Setting Common Properties for all HMI Controls ....................... 77
  5.3 Common Configuration Options ............................................. 78
    5.3.1 Structure of an HMI Control Configurator .......................... 78
    5.3.2 Common Settings .......................................................... 80
    5.3.3 Filters ........................................................................... 82
      5.3.3.1 Structure .................................................................. 83
      5.3.3.2 Using different filters .............................................. 84
      5.3.3.3 FunctionalClasses Filters ........................................ 84
      5.3.3.4 How to activate a filter .......................................... 85
    5.3.4 Services ComPrimitives and Sequences ............................... 87
      5.3.4.1 Structure .................................................................. 87
      5.3.4.2 ComPrimitives ....................................................... 90
      5.3.4.3 How to create a Sequence ....................................... 90
      5.3.4.4 Configuration of ProtocolParameters ......................... 91
    5.3.5 Configuration of Diagnostic Services .................................. 92
      5.3.5.1 Structure .................................................................. 92
      5.3.5.2 How to change the Configuration of a DiagnosticService .. 94

5.4 Setting the ECU Sequence Order .................................................. 96

6 The Monaco HMI Controls ............................................................. 99
  6.1 HMI Control Annotation .......................................................... 100
    6.1.1 Configurator .................................................................. 100
      6.1.1.1 Common Settings ................................................... 101
    6.1.2 HMI Control Bus Trace .................................................... 102
      6.2.1 User Interface ............................................................. 103
      6.2.2 Configurator ............................................................. 106
        6.2.2.1 Common Settings ................................................... 106
    6.2 HMI Control Communication Control .................................... 109
      6.3.1 User Interface ............................................................. 109
      6.3.2 Configurator ............................................................. 110
        6.3.2.1 Overview ............................................................. 111
        6.3.2.2 Common Settings ................................................... 112
6.8.2.1 Common Settings ................................................................. 166
6.8.2.2 ECU Sequence Configuration .......................................... 167

6.9 HMI Control ECU Identification .............................................. 173
6.9.1 User Interface .................................................................. 173
6.9.2 Configurator .................................................................... 174
6.9.2.1 Common Settings............................................................ 175
6.9.2.2 Filters ........................................................................ 176

6.10 HMI Control Flash Programming .......................................... 176
6.10.1 User Interface .................................................................. 177
6.10.2 Configurator .................................................................... 178
6.10.2.1 Common Settings............................................................ 178
6.10.2.2 Filters ........................................................................ 182

6.11 HMI Control Graphical Instrument ....................................... 183
6.11.1 Configuration of the Data Server ........................................ 183
6.11.1.1 Overview .................................................................. 183
6.11.2 Configuration of the Instrument ........................................ 186
6.11.2.1 Overview .................................................................. 186
6.11.2.2 Common Settings............................................................ 188
6.11.2.3 Parameters .................................................................. 189
6.11.3 The Instrument Types ......................................................... 191
6.11.3.1 Oscilloscope ................................................................. 191
6.11.3.2 Angular Gauge ............................................................ 193
6.11.3.3 Slider ....................................................................... 195
6.11.3.4 Bar Graph .................................................................. 196
6.11.3.5 7-Segment Display ....................................................... 198
6.11.3.6 Knob ......................................................................... 199
6.11.3.7 ToggleButton ............................................................... 201
6.11.3.8 Input Field .................................................................. 201
6.11.3.9 Output Field ................................................................. 202
6.11.3.10 LED ......................................................................... 203
6.11.3.11 Thermometer .............................................................. 204
6.11.3.12 Level Indicator ............................................................ 205

6.12 HMI Control IO Control ......................................................... 207
6.12.1 User Interface .................................................................. 208
6.12.2 Configurator .................................................................... 211
6.12.2.1 Overview .................................................................. 211
6.12.2.2 Common Settings............................................................ 212

6.13 HMI Control Logical Link List ............................................... 214
6.13.1 User Interface .................................................................. 215
6.13.2 Configurator .................................................................... 217
6.13.2.1 Common Settings............................................................ 217
6.13.2.2 Filters ........................................................................ 220

6.14 HMI Control OBD ................................................................. 221
6.14.1 User Interface

6.14.1.1 Mode 1 requestCurrentPowertrainDiagnosticData ........................................ 221
6.14.1.2 Mode 2 requestPowertrainFreezeFrameData ................................................. 222
6.14.1.3 Mode 3 requestEmissionRelatedPowertrainDTC ........................................ 223
6.14.1.4 Mode 4 clearResetEmissionRelatedDiagnosticInformation ............................ 223
6.14.1.5 Mode 5 requestOxygenSensorMonitoringTestResults ................................. 224
6.14.1.6 Mode 6 requestOnBoardMonitTestResForNonContinMonit-Systems ..................... 224
6.14.1.7 Mode 7 requestEmissionRelatedDTCsDetectedDuringDrivingCycle .................... 225
6.14.1.8 Mode 8 controlOfOnBoardDevice ............................................................... 225
6.14.1.9 Mode 9 requestVehicleInformation ............................................................ 225
6.14.1.10 Mode A requestEmissionRelatedDTCsWithPermanentStatus ......................... 225

6.14.2 Configurator ........................................................................................................ 226
6.14.2.1 Common Settings ............................................................................................ 226

6.15 HMI Control OTX Script Condole............................................................................ 227
6.15.1 User Interface ..................................................................................................... 227
6.15.2 Configurator ........................................................................................................ 228
6.15.2.1 Common Settings ............................................................................................ 228

6.16 HMI Control Recorder ........................................................................................... 229
6.16.1 User Interface ..................................................................................................... 229
6.16.2 Configurator ........................................................................................................ 230
6.16.2.1 Common Settings ............................................................................................ 230

6.17 HMI Control SoftKey ............................................................................................. 231
6.17.1 User Interface ..................................................................................................... 231
6.17.2 Configurator ........................................................................................................ 232
6.17.2.1 Overview ......................................................................................................... 232
6.17.2.2 Common Settings ............................................................................................ 232

6.18 HMI Control Symbolic Trace .................................................................................... 233
6.18.1 User Interface ..................................................................................................... 233
6.18.2 Configurator ........................................................................................................ 234
6.18.2.1 Common Settings ............................................................................................ 234

6.19 HMI Control Toggle Button ....................................................................................... 235
6.19.1 User Interface ..................................................................................................... 235
<table>
<thead>
<tr>
<th>Section</th>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>6.19.2</td>
<td>Configurator</td>
<td>263</td>
</tr>
<tr>
<td>6.19.2.1</td>
<td>Overview</td>
<td>263</td>
</tr>
<tr>
<td>6.20</td>
<td>HMI Control Tool Quick Test</td>
<td>265</td>
</tr>
<tr>
<td>6.20.1</td>
<td>User Interface</td>
<td>266</td>
</tr>
<tr>
<td>6.20.1.1</td>
<td>ECU S Window</td>
<td>268</td>
</tr>
<tr>
<td>6.20.1.2</td>
<td>ECU Identification Windows</td>
<td>271</td>
</tr>
<tr>
<td>6.20.1.3</td>
<td>Errors and Environment Data Windows</td>
<td>272</td>
</tr>
<tr>
<td>6.20.1.4</td>
<td>FiNAS Report</td>
<td>273</td>
</tr>
<tr>
<td>6.20.2</td>
<td>Configurator</td>
<td>274</td>
</tr>
<tr>
<td>6.20.2.1</td>
<td>Common Settings</td>
<td>274</td>
</tr>
<tr>
<td>6.20.2.2</td>
<td>Filters</td>
<td>279</td>
</tr>
<tr>
<td>6.20.2.3</td>
<td>Tool Quick Test Sequence Editor</td>
<td>280</td>
</tr>
<tr>
<td>6.21</td>
<td>HMI Control Variant Coding</td>
<td>282</td>
</tr>
<tr>
<td>6.21.1</td>
<td>User Interface</td>
<td>283</td>
</tr>
<tr>
<td>6.21.2</td>
<td>Configurator</td>
<td>289</td>
</tr>
<tr>
<td>6.21.2.1</td>
<td>Overview</td>
<td>289</td>
</tr>
<tr>
<td>6.21.2.2</td>
<td>Common Settings</td>
<td>290</td>
</tr>
<tr>
<td>6.22</td>
<td>HMI Control VRX Differ</td>
<td>292</td>
</tr>
<tr>
<td>6.22.1</td>
<td>User Interface</td>
<td>292</td>
</tr>
<tr>
<td>6.22.2</td>
<td>Configurator</td>
<td>295</td>
</tr>
<tr>
<td>6.22.2.1</td>
<td>Common Settings</td>
<td>296</td>
</tr>
</tbody>
</table>

7 Snapshots | 298

8 Tracing Options | 299
1 Overview

DTS Monaco is universal Engineering Tester for Diagnostic and Control Functions of Vehicle ECUs. The name Monaco is derived from Modular Analyzer for Vehicle Communication.

DTS Monaco comprehensively covers all tasks in the areas of engineering, testing and preparation of manufacturing tests:

- diagnostics
- analysis
- OBD
- flash programming
- measuring
- parameterizing
- residual bus simulation
- OTX

DTS Monaco is based on standards such as ODX, OTX and UDS.

Supported Database Formats
Monaco supports ODX 2.2.0 databases and version 3.0 Daimler CxF files.

Monaco Framework
DTS Monaco provides a framework that can be configured and modified by the user. Diagnostic functionality is realized by using several HMI Controls (Human Machine Interface Control), which are independent of the application itself. HMI Controls provide specialized interfaces for each user task (e.g. DTC access, coding of an ECU variant, flash access, reading measurement values, etc.).

Monaco Toolbox
The Monaco HMI Controls are part of a user interface subsystem, called Toolbox. For more information on the Toolbox and its HMI Controls, have a look at the chapter The Monaco HMI Controls. An overview of this structure is given in the figure below.
Monaco Operation Modes

Monaco provides two operation modes:

• **Configuration Mode**

  In **Configuration Mode** the layout and the controls of the User Interface will be designed. This is done by the Interface Designer, a person that owns a special license and has the skills to configure the Monaco Toolbox elements.

  The Monaco workspace created by the Interface Designer is used by other people, the Operators, to execute their tasks. Operators only work in **Execution Mode**.

  To operate Monaco in Configuration Mode a Monaco Interface Designer (MIND) license option is required.

• **Execution Mode**

  When Monaco is in **Execution Mode**, the user interface cannot be changed. Monaco only will allow to work with the HMI Controls the Interface Designer has applied to the workspace currently loaded.

  In some cases the Interface Designer may have placed a *Configure* button in a HMI Control giving access to its configuration during Execution Mode.

When Configuration Mode is active, Execution Mode is disabled and vice versa. This helps to keep data consistent and is in general a convenient way of creating working configurations and preventing operators from changing a working configuration.

2 **Starting Monaco**

To start DTS Monaco open the Windows Start Menu, go to *All Programs* and open the program group *Diagnostic Tool Set 8*. Select the shortcut *DTS Monaco*. 

10
Immediately after start a warning will pop up, that the software may influence and control electronic systems in a way, that may lead to physical injury or damage.

Select Yes, I am to go on or No if you do not agree.

DTS Monaco is now initializing the DTS Base System and the Monaco Start Page will appear.

In the Start Page the following options are available:

- **Edit (Configuration Mode)**
– Create a new workspace

This option creates a completely new Monaco workspace. Monaco will open in Configuration Mode allowing to add new Layouts and HMI Controls.

– Open a workspace

This option opens an existing Monaco workspace in Configuration Mode. Select an existing workspace from the All workspaces tab or one of the recently used workspaces in the Recent workspaces tab. The tab Templates offers predefined workspaces that may be customized to your needs when you have a license to use Monaco in Configuration Mode.

– Open the most recently used workspace

This option opens the Monaco workspace that was used before Monaco was closed the last time in Configuration Mode.

• Start (Execution mode)

– Open a workspace

This option opens an existing Monaco workspace in Execution Mode. Select an existing workspace from the All workspaces tab or one of the recently used workspaces in the Recent workspaces tab.

– Open the most recently used workspace

This option opens the Monaco workspace that was used before Monaco was closed the last time in Execution Mode.

• Administre and manage DTS projects

Selecting this option opens the System Configurator.

• Enter demonstration mode and open the example workspace

Opens Monaco in Demonstration Mode. The Example Project is loaded.

If you want to test Monaco without a license or you want to test features that are beyond your current license scope make sure you switch your hardware interface type in the System Configurator to Simulation. Disable all other Interfaces.
3 Working in Execution Mode

Execution Mode is used to work with the Layout and the HMI Controls of an existing workspace.
The workspace file contains a Monaco configuration designed by a user that owns a Monaco Interface Designer license.

User Interface
See chapter The User Interface In Execution Mode to get an overview of the Monaco user interface in Execution Mode.

Loading an Existing Workspace
In order to execute the HMI Controls of a workspace configuration the workspace file has to be loaded.
To load an existing workspace you have the following options:

- Select Open from the File menu
- Select Open a workspace from the Start Page
- Select Switch workspace from the File menu to load a workspace file that is part of the same DTS project

(For more details see chapter Opening a Workspace).

Start and Stop the Execution after Loading.
In Execution Mode the execution of the HMI Controls can be started or stopped.
When the execution is started, the HMI Controls of the loaded workspace are activated (executed).
When the execution is stopped, the HMI Controls are deactivated.
(For more details see chapter Starting and Stopping the Execution).

Start and Stop the Instruments
If the Monaco configuration contains HMI Controls from type Graphical Instrument these HMI Controls may be started separately.
For more details see chapter Starting and Stopping the Instruments.

Creating Snapshots
Snapshots are used to store and report the current state of one or a couple of HMI Controls.
For more details see chapter Snapshots.

Constant Layout
3.1 The User Interface In Execution Mode

Select Show constant layout from the Execution menu to display or hide the Constant Layout.

Service Tree
Some HMI Controls require the Service Tree Control to allow services and ComPrimitives been dragged and dropped while a Monaco workspace configuration is started.

Switching to Configuration Mode
Press Ctrl+F4 or select Configuration mode from the Execution menu to switch to Configuration Mode.

In Configuration Mode you can configure all HMI Controls and the workspace configuration.

Note: You need a Monaco Interface Designer License to work in Configuration Mode

Global Protocol Parameter Configuration
Protocol Parameter Settings can be set globally for each protocol that is used in the current project. See Global Protocol Parameter Settings.

3.1 The User Interface In Execution Mode

The Figure below shows the user interface of the Monaco Framework in Execution Mode.

The user interface of DTS-Monaco in Execution Mode contains the following elements:

• Menu Bar
3.1. The User Interface In Execution Mode

Menu of DTS Monaco. Some items may be disabled because they are not supported in Configuration Mode or Execution Mode or a HMI Control or Layout has to be selected first.

• **Toolbar**
  Provides icons for main features (open, save, etc.). The available buttons depend on whether Configuration Mode or Execution Mode is activated (see chapter The Monaco Toolbar in Execution Mode).

• **Constant Layout**
  The Constant Layout Area is a layout that is displayed when the button *Toggle Constant Bar* from the Toolbar is pressed or the Menu item *Show constant layout* from the **Execution** menu is selected.

When the Constant Layout is active it will be always visible. For this the Layout Area is reduced. The size of the Constant Layout may be reduced or enlarged using the separation bar between Constant Layout and Layout Area.

The Constant Layout area can only contain a single layout.

• **Layout Area**
  Provides one or more layouts that contain the HMI Controls.
  The layouts can be switched by clicking on the appropriate tab at the top of the Layout Area.

• **Status Bar**
  The status bar displays some status information of Monaco, e.g. if Configuration Mode or Execution Mode is activated or if a DoIP ECU is available and if NUM lock key or CAPS lock key is activated.

• **Status Message Area**
  The *Status Message Area* shows error messages of the DTS-COS (MVCI-Server).
  It will be displayed when *Show status message area* from the **View** menu is checked.
  Take a look at *Status Message Area* for detailed information about the Status View.

### 3.1.1 The Monaco Menu Bar in Execution Mode

The following sections describe the Monaco menu bar.

• **File Menu**
3.1. The User Interface In Execution Mode

- Edit Menu
- View Menu
- Execution Menu
- Tools Menu
- Help Menu

3.1.1.1 File Menu

The following table provides an overview of the File menu.

<table>
<thead>
<tr>
<th>Item [Shortcut]</th>
<th>Remarks</th>
</tr>
</thead>
<tbody>
<tr>
<td>New... [Ctrl+N]</td>
<td>Creates a new workspace. For more information about a Monaco Workspace see chapter Creating a new workspace. This item is only available in Configuration Mode.</td>
</tr>
<tr>
<td>Open... [Ctrl+O]</td>
<td>Opens an existing workspace from the current DTS project or from another DTS project. See chapter Opening a Workspace.</td>
</tr>
<tr>
<td>Close</td>
<td>Closes the current workspace and returns to the Monaco Start Page. When the current workspace has been modified, the user is asked to save the workspace before closing.</td>
</tr>
<tr>
<td>Switch workspace...</td>
<td>Opens an existing Workspace which belongs to the current DTS project. This option reduces switching time between different Monaco Workspaces in a DTS project as the database has not to be reloaded.</td>
</tr>
<tr>
<td>Save [Ctrl+S]</td>
<td>Saves the current Workspace.</td>
</tr>
</tbody>
</table>
3.1. The User Interface In Execution Mode

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Save As...</strong></td>
<td>Saves the current Workspace to a new Workspace file within the current DTS project. The Save workspace as dialog window will open, allowing the user to enter a file name for the new workspace configuration file.</td>
</tr>
<tr>
<td></td>
<td><img src="image" alt="Image of Save workspace as dialog" /></td>
</tr>
<tr>
<td></td>
<td>Click <strong>New...</strong> to create a new subfolder.</td>
</tr>
<tr>
<td></td>
<td>Click <strong>Open</strong> to open the selected subfolder</td>
</tr>
<tr>
<td></td>
<td>Click <strong>OK</strong> to save the new configuration</td>
</tr>
<tr>
<td></td>
<td>Click <strong>Cancel</strong> to close the dialog without saving the workspace to a new file.</td>
</tr>
<tr>
<td></td>
<td>If you right-click in the configuration box a context menu pops up:</td>
</tr>
<tr>
<td></td>
<td><strong>New</strong>: creates a subfolder</td>
</tr>
<tr>
<td></td>
<td><strong>Delete</strong>: deletes a subfolder</td>
</tr>
<tr>
<td></td>
<td><strong>Rename</strong>: renames an existing subfolder</td>
</tr>
<tr>
<td><strong>Save as template...</strong></td>
<td>Saves the current workspace configuration to a new or existing Monaco Workspace Template. For more information about Templates see chapter Creating a Workspace Template. This item is only available in Configuration Mode.</td>
</tr>
<tr>
<td><strong>Recent Files</strong></td>
<td>Opens a Workspace from the list of recently used workspaces.</td>
</tr>
<tr>
<td><strong>Exit [Alt+F4]</strong></td>
<td>Closes DTS Monaco.</td>
</tr>
</tbody>
</table>
3.1. The User Interface In Execution Mode

3.1.1.2 Edit Menu

The following table provides an overview of the Edit menu. It is used to duplicate, move and delete Layouts and HMI Controls in Configuration Mode.

<table>
<thead>
<tr>
<th>Item [Shortcut]</th>
<th>Remarks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cut [Ctrl+X]</td>
<td>The selected HMI Control is removed from the layout and copied to the Monaco clipboard. The content of the clipboard may be inserted in another layout using the Paste command. This item is only available in Configuration Mode.</td>
</tr>
<tr>
<td>Copy [Ctrl+C]</td>
<td>The selected HMI Control is copied to the Monaco clipboard. It is not removed from the layout. The content of the clipboard may be inserted in another layout using the Paste command. This item is only available in Configuration Mode.</td>
</tr>
<tr>
<td>Paste [Ctrl+V]</td>
<td>The content of the Monaco clipboard is inserted in the currently selected layout. This item is only available in Configuration Mode.</td>
</tr>
<tr>
<td>Delete [Ctrl+Del]</td>
<td>The selected Layout or a selected HMI Control is removed from the user interface. This item is only available in Configuration Mode.</td>
</tr>
</tbody>
</table>

3.1.1.3 View Menu

The following table provides an overview of the View menu.

<table>
<thead>
<tr>
<th>Item [Shortcut]</th>
<th>Remarks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Constant layout [Ctrl+1]</td>
<td>If selected, the Windows input focus will be set on the Constant Layout area. If the Constant Layout is not visible it will be brought to front.</td>
</tr>
<tr>
<td>Status message area [Ctrl+2]</td>
<td>If selected, the Windows input focus will be set on the Status Message area.</td>
</tr>
</tbody>
</table>
### 3.1. The User Interface In Execution Mode

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Layout area [Ctrl+3]</strong></td>
<td>If selected, the Windows input focus will be set on the <em>Layout</em> area. The first Layout is selected. To switch to another Layout use the (left and right) arrow keys of your keyboard.</td>
</tr>
<tr>
<td><strong>Configuration bar [Ctrl+4]</strong></td>
<td>If selected, the Windows input focus will be set on the <em>Configuration Bar</em>. If the Configuration Bar is not visible it will be brought to front. This item is only available in <em>Configuration Mode</em>.</td>
</tr>
<tr>
<td><strong>HMI Control bar [Ctrl+5]</strong></td>
<td>If selected, the Windows input focus will be set on the <em>HMI Control bar</em>. This feature is not implemented yet.</td>
</tr>
<tr>
<td><strong>Property sheet [Ctrl+6]</strong></td>
<td>If selected, the Windows input focus will be set on the <em>Property Sheet</em>. If the <em>Property Sheet</em> is not visible it will be brought to front. This item is only available in <em>Configuration Mode</em>.</td>
</tr>
<tr>
<td><strong>Show tool bar</strong></td>
<td>If checked, the Monaco <em>Toolbar</em> will be displayed. The status is shown by a check mark in front of the item. For more information see chapter <em>Tool Bar</em>.</td>
</tr>
<tr>
<td><strong>Show status bar</strong></td>
<td>If checked, the Monaco <em>Status Bar</em> will be displayed. The status is shown by a check mark in front of the item. For more information see chapter <em>Status Bar</em>. This feature is not implemented yet.</td>
</tr>
<tr>
<td><strong>Show status message area</strong></td>
<td>If checked, the Monaco <em>Status Message Area</em> will be displayed. The status is shown by a check mark in front of the item. For more information see chapter <em>Status Message Area</em>.</td>
</tr>
<tr>
<td><strong>Show configuration bar</strong></td>
<td>If checked, the Monaco <em>Configuration Bar</em> will be displayed. The status is shown by a check mark in front of the item. For more information see chapter <em>Configuration Bar</em>. This item is only available in <em>Configuration Mode</em>.</td>
</tr>
<tr>
<td><strong>Show HMI Control bar</strong></td>
<td>If checked, the <em>HMI Control bar</em> will be displayed. This feature is not implemented yet.</td>
</tr>
</tbody>
</table>
3.1. The User Interface In Execution Mode

Show property sheet

If checked, the Monaco Property Sheet will be displayed. The status is shown by a check mark in front of the item. For more information see chapter Property Sheet. This item is only available in Configuration Mode.

Clear output windows

If selected, the content of all output windows will be cleared.

Show debug window

If selected, the debug window will be displayed.

3.1.1.4 Execution Menu

The following table provides an overview of the Executions menu.

<table>
<thead>
<tr>
<th>Item [Shortcut]</th>
<th>Remarks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show service tree</td>
<td>Displays the Service Tree) The status is shown by a check mark in front of the item. More information about the Service Tree you will find in the chapter Service Tree.</td>
</tr>
<tr>
<td>Show constant layout</td>
<td>Displays the Constant Layout area The status is shown by a check mark in front of the item. For more information about the Constant Layout see chapter Elements of the User Interface.</td>
</tr>
</tbody>
</table>
3.1. The User Interface In Execution Mode

| Start [F5] | **Start** activates all HMI Controls in the selected workspace of the DTS project.  
If the configuration is already started this item is disabled. Depending on the **Workspace Options** either all HMI Controls of all Layouts are started or only the HMI Controls of the visible (selected) Layout are started.  
Monaco can be configured to start automatically after loading a workspace.  
The HMI Controls of the Constant Layout will always be started regardless of the configuration options. The Constant Layout is always the first Layout to be started. After that the Layouts of the Layout area are started using the Layout sequence order. Within a Layout, the HMI Controls are activated in the order defined by the HMI Control sequence order. (For more details see chapter **Starting and Stopping the Execution**.) |
|---|---|
| Stop [Shift+F5] | **Stop** stops the execution of all running HMI Controls.  
Before stopping the HMI Controls, the Monaco Framework checks whether all started HMI Controls are ready to terminate their actions. If one or more HMI Controls are not ready, no HMI Control is stopped, an error message is displayed and the configuration remains active.  
If the execution is not started, this item is disabled. (For more details see chapter **Starting and Stopping the Execution**.) |
| Write Snapshot [F8] | If **Write Snapshot** is selected, a snapshot is written for selected HMI Controls (see chapter **Snapshots**). |
| View Snapshot [Shift+F8] | Not implemented yet. For more information about Snapshots see **Snapshots**. |
| Start Instruments | **Start Instruments** enables the execution of all HMI Controls from type **Instrument**.  
The item is disabled, when the flag **Start Instruments automatically** is set. See chapter **Workspace Options**.  
For more information about the **HMI Control Graphical Instrument** see chapter **HMI Control Graphical Instrument**. |
3.1. The User Interface In Execution Mode

<table>
<thead>
<tr>
<th>Item</th>
<th>Remarks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Stop Instruments</td>
<td>If Stop Instruments is selected, the execution of all HMI Controls from type Instrument stops. The item is disabled, when the flag Start Instruments automatically is set. See chapter Workspace Options. For more information about the HMI Control Graphical Instrument see chapter HMI Control Graphical Instrument.</td>
</tr>
<tr>
<td>Ethernet activation</td>
<td>If Ethernet Activation is selected, Monaco tries to set up the DoIP channel. This means the Ethernet activation pin of the eCOM VCI is set to 6 volt and a broadcast request is sent on the Ethernet port. If a DoIP ECU is detected every HMI Control will be updated and will show the newly detected Logical Links. The status pane at the status bar shows DoIP ECU available, and changes the color to green. For further information about the Status Bar please have a look at chapter The User Interface In Execution Mode.</td>
</tr>
</tbody>
</table>

3.1.1.5 Tools Menu

The following table provides an overview of the Tools menu.

<table>
<thead>
<tr>
<th>Item [Shortcut]</th>
<th>Remarks</th>
</tr>
</thead>
</table>
### Configure column handling...

Opens a dialog to configure the *Column Handling* in *Execution Mode*.

The setting affects all HMI Controls with lists except the *Bus Trace* and *Symbolic Trace* HMI Controls.

There are two options available:

- **Absolute**: The size of every column can be arranged without affecting the neighbor columns. If columns get out of the visible area of the list a scroll bar will appear.

- **Relative**: All columns are always in the visible area of the list. If the size of one column is changed the neighbor column to the right will also change its size in order to fit in the visible area of the list.

### Configure ECU sequence order...

Opens the *ECU Sequence Order Configurator*. This configurator is able to determine the order of the ECUs in which they are handled in sequences. This order is used by HMI Controls that have a Sequence Editor, e.g. Complete Vehicle Coding. See *Setting the ECU Sequence Order*.

This item is only available in *Configuration Mode*. 
3.1. The User Interface In Execution Mode

3.1.1.6 Help Menu

The following table provides an overview of the Help menu.

<table>
<thead>
<tr>
<th>Item [Shortcut]</th>
<th>Remarks</th>
</tr>
</thead>
<tbody>
<tr>
<td>DTS Monaco help [F1]</td>
<td>Opens the DTS Monaco integrated help system.</td>
</tr>
</tbody>
</table>
3.1. The User Interface In Execution Mode

Support Provides information required by Softing support. Please copy and paste the content of this dialog to your problem description, when you contact Softing Support by email.

About DTS Monaco... Opens the About dialog containing information about DTS Monaco, such as details of the version and supplier.

### 3.1.2 The Monaco Toolbar in Execution Mode

The toolbar in *Execution Mode* provides the following buttons.

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Action</th>
<th>Remarks</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Folder" /></td>
<td>New</td>
<td><code>File Menu - New</code></td>
</tr>
<tr>
<td><img src="image" alt="Folder" /></td>
<td>Open</td>
<td><code>File Menu - Open</code></td>
</tr>
<tr>
<td><img src="image" alt="Folder" /></td>
<td>Open Configuration</td>
<td><code>File Menu - Open Configuration</code></td>
</tr>
<tr>
<td><img src="image" alt="Folder" /></td>
<td>Save</td>
<td><code>File Menu - Save</code></td>
</tr>
<tr>
<td><img src="image" alt="Scissors" /></td>
<td>Cut</td>
<td><code>Edit Menu - Cut</code></td>
</tr>
<tr>
<td><img src="image" alt="Folder" /></td>
<td>Copy</td>
<td><code>Edit Menu - Copy</code></td>
</tr>
<tr>
<td><img src="image" alt="Folder" /></td>
<td>Paste</td>
<td><code>Edit Menu - Paste</code></td>
</tr>
<tr>
<td><img src="image" alt="Delete" /></td>
<td>Delete</td>
<td><code>Edit Menu - Delete</code></td>
</tr>
<tr>
<td><img src="image" alt="Table" /></td>
<td>Toggle Constant Layout</td>
<td><code>View Menu - Constant Layout</code></td>
</tr>
</tbody>
</table>
### 3.1.3 Service Tree

#### General Information

The Service Tree is part of the standard delivery of the Monaco Toolbox. It works similar to a Monaco HMI Control.

It displays a tree of the diagnostic data (Services or OTX Scripts). In Execution Mode tree items can be dragged and dropped into the following Monaco HMI controls:

- Data Display
- IO Control
- Recorder

<table>
<thead>
<tr>
<th>Action</th>
<th>Menu</th>
</tr>
</thead>
<tbody>
<tr>
<td>Toggle Service Tree</td>
<td>View Menu - Service Tree</td>
</tr>
<tr>
<td>Switch to Configuration Mode</td>
<td>View Menu - Configuration Mode</td>
</tr>
<tr>
<td>Start Execution</td>
<td>Execution Menu - Start</td>
</tr>
<tr>
<td>Stop Execution</td>
<td>Execution Menu - Stop</td>
</tr>
<tr>
<td>Clear All</td>
<td>View Menu - Clear All</td>
</tr>
<tr>
<td>Ethernet Activation</td>
<td>Execution Menu - Ethernet Activation</td>
</tr>
<tr>
<td>OTX-Editor</td>
<td>Tools Menu - OTX Editor</td>
</tr>
<tr>
<td>Start Daimler Software Station</td>
<td>Tools Menu - Software Station</td>
</tr>
<tr>
<td>Help</td>
<td>Help Menu</td>
</tr>
</tbody>
</table>
To open the Service Tree window select the menu item Service Tree in the Monaco View menu or click on the corresponding button in the Monaco Toolbar.

The Service Tree offers the following items:

- Base Variants (Logical Links)
- Variants of a Base Variant.
- MCD 3D Data Primitives of a Base Variant or a Variant
- MCD 3D Control Primitives of a Protocol, a Functional Group, a Base Variant or a Variant
- Hex Services of a Base Variant or a Variant
- Protocol Parameter Sets of a Base Variant or a Variant
- Display of MCD 3D Data Primitives in a Functional Class view.

### 3.1.3.1 User Interface

The pre-configured Service Tree Control is shown in the image below.
3.1. The User Interface In Execution Mode

The largest part of the Service Tree window is reserved for the tree of diagnostic services. All items in the tree are sorted by name. The tree items can either display their long name or their short name. This option may be set in the Configurator.

The root nodes of the tree can be a Base Variant of an ECU, a Functional Group or a Protocol.

Each root node has the following structure:

- Services (All MCD Data Primitives)
  In the Configurator the presentation of the Services can either be set to a Functional Class view or to an alphanumeric ascending order. Another parameter, Show Service Identifier, in the Configurator shows the service with a leading service identifier.
3.1. The User Interface In Execution Mode

- Hex and Raw Services (All user defined Hex Services)
- Protocol Parameter Sets (All user defined Protocol Parameter Sets)
- ComPrimitives (All MCD Control Primitives)

Nodes of Base Variants additionally contain all their Variants.

**Searching the Service Tree**
The Service Tree HMI Control features a Search option. To start a search choose a node you want to search through. Click in the search field with the default text `<Enter search pattern>` located above the service tree and enter a string you want to search for. A box will open with all items that matched the search string. When you select an item, the box is closed and the item is marked in the Service Tree.

When you enable the checkbox *Global Search* the whole database will be searched. In case of a large database the search may take several minutes.

**Entering Configuration Mode**
On the right there may be a button named *Configure*. This button allows entering the Configurator of the Service Tree during runtime. The visibility of this button has to be set in the Configurator in tab *Common Settings*.

**3.1.3.2 Configurator**
The Configurator Settings control the behavior of the Service Tree in Execution Mode.

The figure below shows the dialog window *Service Tree - Configurator*.
3.1. The User Interface In Execution Mode

The Configurator features the following tabs:

- **Common Settings**
- **Filters**

The following buttons are available:

- **Help**: Opens the appropriate chapter in the help file of Monaco
- **Save and Close**: Saves the current configuration and closes the Configurator
- **Cancel**: Aborts all changes and closes the Configurator

### 3.1.3.3 Common Settings

The following table gives an overview of all properties and their values in the tab **Common Settings**. Default values are represented in bold letters.

<table>
<thead>
<tr>
<th>Property</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>General</strong></td>
<td></td>
</tr>
<tr>
<td>Caption</td>
<td>Service Tree</td>
</tr>
<tr>
<td>Show Frame</td>
<td>true</td>
</tr>
<tr>
<td>Show LongNames</td>
<td>true</td>
</tr>
<tr>
<td>Show Service Identifiers</td>
<td>false</td>
</tr>
<tr>
<td>Show Functional Classes</td>
<td>true</td>
</tr>
<tr>
<td>Show LogicalLinks on Variants</td>
<td>false</td>
</tr>
<tr>
<td>Show Protocols</td>
<td>false</td>
</tr>
<tr>
<td>Show Functional Groups</td>
<td>true</td>
</tr>
<tr>
<td><strong>Configure Button</strong></td>
<td></td>
</tr>
<tr>
<td>Visible</td>
<td>false</td>
</tr>
<tr>
<td>Caption</td>
<td>Configure</td>
</tr>
</tbody>
</table>

![Image of the Configurator window with Common Settings and Filters tabs open]
3.1. The User Interface In Execution Mode

<table>
<thead>
<tr>
<th>PROPERTY</th>
<th>VALUES</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>General/Caption</td>
<td>Service Tree/any character string</td>
<td>Name of the Control that will be displayed in its surrounding frame.</td>
</tr>
<tr>
<td>General/Show Frame</td>
<td>true/false</td>
<td>Displays the control with or without frame and caption</td>
</tr>
<tr>
<td>General/Show Long-Names</td>
<td>true/false</td>
<td>Displays the LongNames or ShortNames of the tree items</td>
</tr>
<tr>
<td>General/Show Service Identifier</td>
<td>true/false</td>
<td>Shows the Service Identifier in front of the service name</td>
</tr>
<tr>
<td>General/Show Functional Classes</td>
<td>true/false</td>
<td>Displays the Functional Classes</td>
</tr>
<tr>
<td>General/Show LogicalLinks on Variants</td>
<td>true/false</td>
<td>Displays the Variants of a Base Variant</td>
</tr>
<tr>
<td>General/Show Protocols</td>
<td>true/false</td>
<td>Displays the Protocol Locations</td>
</tr>
<tr>
<td>General/Show Functional Group</td>
<td>true/false</td>
<td>Displays the Functional Group</td>
</tr>
<tr>
<td>Configure Button/Visible</td>
<td>true/false</td>
<td>Enables or disables the Configure Button in the Service Tree</td>
</tr>
<tr>
<td>Configure Button/Caption</td>
<td>Configure</td>
<td>Determines the text of the Configure Button</td>
</tr>
</tbody>
</table>

**3.1.3.4 Filters**

The *Filters* tab controls which Logical Links will be displayed in the Logical Link list of the Service Tree.

It has the following layout:
3.1. The User Interface In Execution Mode

The Filters tab lists all Logical Links of the DTS project.

The following table gives an overview of all properties and their values of the tab Filters. Default values are represented in bold letters.

<table>
<thead>
<tr>
<th>PROPERTY</th>
<th>VALUES</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>LogicalLink filter</td>
<td>off/on</td>
<td>on: enables Logical Link filtering, off: every Logical Link in the DTS project is listed in the Logical Link list of the Service Tree</td>
</tr>
<tr>
<td>LogicalLink filter/Link Name</td>
<td>pass/reject</td>
<td>pass: this Logical Link will be listed in Logical Link list of the Service Tree; reject: this Logical Link will not be listed</td>
</tr>
<tr>
<td>FunctionalClasses filter</td>
<td>off/on</td>
<td>on: enables Functional Class filtering, off: every Functional Class in the DTS project is listed in the Functional Class list of the Service Tree</td>
</tr>
</tbody>
</table>
3.1. The User Interface In Execution Mode

| FunctionalClasses filter/Functional Class Name | pass/reject | pass: this Functional Class will be listed in Functional Class list of the Service Tree; reject: this Functional Class will not be listed |

3.1.4 Status Message Area

The Status Message Area is part of the standard delivery of the Toolbox. It is intended to visualize all global information of system and communication states (e.g. error messages).

It is visible in Execution Mode as well as in Configuration Mode.

The Status Message Area will be displayed when Show status message area in the View menu is checked.

Elements of the Status Message Area
(from left to right)

- **Output Window**
  The output window shows error messages and the error history of the DTS-COS (MVCI-Server).
  It consists of a combo box which is filled continuously with new entries added at the lowest position.
  The latest entry will always be displayed if the combo box is closed.

- **Button Clear**
  A click on the Clear button hides the displayed line (it does not delete it from the combo box).
  A second click on this button deletes all entries from the combo box.

- **Button Copy Messages to Clipboard**
  A click on the Copy to Clipboard button copies the content of the output window to the Windows Clipboard.
  This may be used for attaching error information to a support request.
3.2 Opening a workspace

- **Display Window**
  The display box provides the name of the selected DTS project and the corresponding selected Vehicle Information Table.
  As long as no DTS project and no Vehicle Information Table (VIT) are selected the corresponding display box remains empty.

3.2 Opening a workspace

Usually a user launches the Monaco Framework to work with an existing configuration (particularly in the case of a standard user).

The *Open workspace* dialog consists of a tab control with three different tabs.

- **All workspaces**
  The tab *All workspaces* provides a tree of all DTS Projects and their predefined configurations (if available). The DTS Projects have to be imported by the System Configurator first in order to get the contained workspaces displayed in this dialog.

- **Recent workspaces**
  The tab *Recent workspaces* provides all workspaces files, which have recently been used.
### 3.2. Opening a workspace

- **Templates**
  The tab *Templates* contains templates, which can be used to create new Monaco configurations.

Select a workspace and click **OK** to open the workspace.

Click **Cancel** to return to the Monaco Start Page.

Click **Help** to open the integrated Monaco help system.
3.3 Starting and Stopping the Execution

When Monaco is in Execution Mode, the execution of the HMI Controls can be started or stopped.

Starting the Execution
To start the execution select Start from the Execution menu or press F5 on your keyboard. This will activate the HMI Controls of all Layouts or only the ones from the currently visible Layout, depending on the settings in the Workspace Options dialog.

Configuration of Start Options
The Start Options of Monaco can be set in the Workspace Options dialog, when Monaco is in Configuration Mode. Select Configure workspace... from the Configuration menu to open the Workspace Options dialog.

The tab Start Options offers the following settings:

- **Start automatically after loading**: When checked the execution of the Monaco workspace is started automatically after loading.
  
  When the checkbox is disabled the Monaco workspace has to be started manually after loading using the Start button from the Toolbar or the Start menu item in the Execution menu.

- **Workspace Start**: There are two different start options for Layouts in the Layout area:
  
  - **Start all Layouts**: The execution of all Layouts and all their HMI Controls is started at the same time.
3.4 Starting and Stopping the Instruments

- **Start only visible Layout**: Only the Layout with its HMI Controls that is currently selected (visible) will be started.

The HMI Controls of the Constant Layout will always be started regardless of the settings in the *Workspace Options* dialog.
The Constant Layout is always the first Layout to be started. After that the Layouts of the Layout area are started using the Layout sequence order.
Within a Layout, the HMI Controls are activated in the order defined by the HMI Control sequence order.

**Stopping the Execution**
To stop the execution of all running HMI Controls select *Stop* from the *Execution* menu or press Shift+F5 on your keyboard.

Before stopping the HMI Controls, the Monaco Framework checks whether all started HMI Controls are ready to terminate their actions.
If one or more HMI Controls are not ready, no HMI Control is stopped, an error message is displayed and the configuration remains active.

### 3.4 Starting and Stopping the Instruments

The execution of HMI Controls from type *Instrument* can be started or stopped separately.
By default HMI Controls from type *Instrument* are not started when a Monaco configuration is started. They have to be started manually.

**Starting the Instruments**
To start the execution all HMI Controls from type *Instrument* select *Start instruments* from the *Execution* menu.
The item is disabled, when the option *Start Instruments automatically* in the *Workspace Options* dialog is checked.
For more information about the HMI Control Graphical Instrument see chapter The Monaco Toolbox *HMI Control Graphical Instrument*.

**Configuration of Start Behavior**
The start behavior of the HMI Controls from type *Instrument* can be set in the *Workspace Options* dialog, when Monaco is in Configuration Mode.
Select *Configure workspace...* from the *Configuration* menu to open the *Workspace Options* dialog.
3.5. Global Protocol Parameter Settings

The tab Start Options offers the option Start Instruments automatically. When this option is checked, the Instruments are started automatically as soon as the execution of the other HMI Controls (see Starting and Stopping the Execution) is started.

Stopping the Execution
To stop the execution all HMI Controls from type Instrument select Stop instruments from the Execution menu.
The item is disabled, when the option Start Instruments automatically in the Workspace Options dialog is checked.

3.5 Global Protocol Parameter Settings

Protocol Parameter Settings can be set globally for each protocol that is used in the current project.
Global Protocol Parameter Settings can be accessed using the option Configure Protocol Parameter Globally... from the Tools menu.

These settings will be saved specific to the project file (ProtocolParams.gpt). When Monaco is restarted the settings are available again.
The communication parameters are set automatically when opening a Logical Link.

The function Set Protocol Parameter Globally... is only available when the execution mode is stopped. To stop the execution mode use the Stop button from the toolbar or select Stop from the Execution menu.

The left tab GlobalProtocolParameterSet shows all available protocols.
3.5. Global Protocol Parameter Settings

In the right tab *Configuration* the communication parameters may be set.

When the user has changed a communication parameter the value turns to green. It is activated when the button *Update Parameters* is pressed.

In the figure below the value of the parameter *CP TesterPresentHandling* from the UDS protocol has been changed to *Disabled*.

To reset a communication parameter to its default select *Reset to inactive* from the context menu of the parameter.

In this case the communication parameter will not be changed when Execution Mode is started and it will not be saved to the project file (ProtocolParams.gpt) anymore.

The settings are applied when you press the button *Update Parameters*.

Globally changed communication parameters are highlighted with orange letters in the ProtocolParameterSet of the ComPrimitives branch of the associated LogicalLink.
The figure below shows the changed parameter \textit{CP.TesterPresentHandling} in the Protocol-ParameterSet ComPrimitive of the LogicalLink BV_ECU.

4 Working in Configuration Mode

Configuration Mode provides a set of tool windows, dialog windows, tool bars and functions to create, delete and edit the Layouts and HMI Controls of the configuration currently loaded.

Only users with an additional Monaco Interface Designer license have access to Configuration Mode. Users that only have a Monaco license do not need Configuration Mode, because they work with configurations, that already exist. Please note, if Simulated Interface is used for communication, UI configurations cannot be saved in Configuration Mode.

User Interface
See chapter The User Interface In ConfigurationMode to get an overview of the Monaco user interface in Configuration Mode.

Main Features

- Creating a new Workspace
  Users with a Interface Designer License can create new Monaco Workspaces, see chapter Creating a new Workspace.

- Opening an Existing Workspace
  To open an existing workspace in Configuration Mode follow the steps described in the chapter Opening a Workspace.
4.1. The User Interface In Configuration Mode

- **Adding a Layout**
  For adding a Layout to a Workspace see chapter Setting Up Layouts.

- **Inserting HMI Controls**
  For adding HMI Controls to a Layout see chapter Working with HMI Controls.

- **Snapshot configuration**
  The displayed data of HMI Controls during Execution Mode can be stored into Snapshot files. They can be configured in terms of the files and the execution. It is possible to define one snapshot file for all HMI Controls or different ones. If different snapshot files are used for HMI Controls, one file can still be used for multiple HMI Controls. The handling of Snapshot configuration is explained in chapter Snapshots.

### 4.1 The User Interface In Configuration Mode

The Figure below shows the user interface of the Monaco Framework in Configuration Mode.

The user interface of DTS-Monaco in Configuration Mode contains the following elements:

- **Menu Bar**
  Menu of DTS Monaco. Some items may be disabled because they are not supported in Configuration Mode or Execution Mode or a HMI Control or Layout has to be selected first.
4.1. The User Interface In Configuration Mode

• **Toolbar**
  Provides icons for main features (open, save, etc.). The available buttons depend on whether Configuration Mode or Execution Mode is activated (see chapter The Monaco Toolbar in Configuration Mode).

• **Constant Layout**
  The Constant Layout Area is a Layout that is displayed when the button Toggle Constant Bar from the Toolbar is pressed or the Menu item Show constant layout from the Execution menu is selected.

  When the Constant Layout is active it will be always visible. For this the Layout Area is reduced. The size of the Constant Layout may be reduced or enlarged using the separation bar between Constant Layout and Layout Area.

  The Constant Layout area can only contain a single Layout.

• **Layout Area**
  Provides one or more layouts that contain the HMI Controls.
  The layouts can be switched by clicking on the appropriate tab at the top of the Layout Area.

• **Status Bar**
  The status bar displays some status information of Monaco, e.g. if Configuration Mode or Execution Mode is activated or if a DoIP ECU is available and if NUM lock key or CAPS lock key is activated.

• **Status Message Area**
  The Status Message Area shows error messages of the DTS-COS (MVCI-Server). It will be displayed when Show status message area from the View menu is checked. Take a look at Status Message Area for detailed information about the Status View.

• **Configuration Bar**
  The Configuration Bar shows the layouts and their HMI Controls in a tree structure (see chapter Configuration Bar).

• **Property Sheet**
  The Property Sheet shows the properties of the currently selected HMI Control or Layout (see chapter Property Sheet).
4.1.1 The Monaco Menu Bar in Configuration Mode

The following sections describe the Monaco menu bar.

- File Menu
- Edit Menu
- View Menu
- Configuration Menu
- Tools Menu
- Help Menu

4.1.1.1 File Menu

The following table provides an overview of the File menu.

<table>
<thead>
<tr>
<th>Item</th>
<th>Remark</th>
</tr>
</thead>
<tbody>
<tr>
<td>New... [Ctrl+N]</td>
<td>Creates a new workspace. For more information about a Monaco Workspace see chapter Creating a new workspace.</td>
</tr>
<tr>
<td>Open... [Ctrl+O]</td>
<td>Opens an existing workspace from the current DTS project or from another DTS project. See chapter Opening a Workspace.</td>
</tr>
<tr>
<td>Close</td>
<td>Closes the current workspace and returns to the Monaco Start Page. When the current workspace has been modified, the user is asked to save the workspace before closing.</td>
</tr>
<tr>
<td>Switch workspace...</td>
<td>Opens an existing Workspace which belongs to the current DTS project. This option reduces switching time between different Monaco Workspaces in a DTS project as the database has not to be reloaded.</td>
</tr>
<tr>
<td>Save [Ctrl+S]</td>
<td>Saves the current Workspace.</td>
</tr>
</tbody>
</table>
4.1. The User Interface In Configuration Mode

<table>
<thead>
<tr>
<th><strong>Save As...</strong></th>
<th>Saves the current workspace to a new workspace file within the current DTS project. The <em>Save workspace as</em> dialog window will open, allowing the user to enter a file name for the new workspace configuration file.</th>
</tr>
</thead>
</table>
| ![Save workspace as dialog window](image) | Click *New...* to create a new subfolder.  
Click *Open* to open the selected subfolder  
Click *OK* to save the new configuration  
Click *Cancel* to close the dialog without saving the workspace to a new file.  
If you right-click in the configuration box a context menu pops up:  
*New*: creates a subfolder  
*Delete*: deletes a subfolder  
*Rename*: renames an existing subfolder |
| **Save as template ...** | Saves the current workspace configuration to a new or existing Monaco Workspace Template.  
For more information about Templates see chapter *Creating a Workspace Template*. |
| **Recent Files** | Opens a workspace from the list of recently used workspaces. |
| **Exit [Alt+F4]** | Closes DTS Monaco. |
4.1. The User Interface In Configuration Mode

4.1.1.2 Edit Menu

The following table provides an overview of the *Edit* menu. It is used to duplicate, move and delete Layouts and HMI Controls.

<table>
<thead>
<tr>
<th>Item [Shortcut]</th>
<th>Remarks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cut [Ctrl+X]</td>
<td>The selected HMI Control is removed from the layout and copied to the Monaco clipboard. The content of the clipboard may be inserted in another layout using the <em>Paste</em> command. This item is only available in <em>Configuration Mode</em>.</td>
</tr>
<tr>
<td>Copy [Ctrl+C]</td>
<td>The selected HMI Control is copied to the Monaco clipboard. It is not removed from the layout. The content of the clipboard may be inserted in another layout using the <em>Paste</em> command. This item is only available in <em>Configuration Mode</em>.</td>
</tr>
<tr>
<td>Paste [Ctrl+V]</td>
<td>The content of the Monaco clipboard is inserted in the currently selected layout. This item is only available in <em>Configuration Mode</em>.</td>
</tr>
<tr>
<td>Delete [Ctrl+Del]</td>
<td>The selected Layout or a selected HMI Control is removed from the user interface. This item is only available in <em>Configuration Mode</em>.</td>
</tr>
</tbody>
</table>

4.1.1.3 View Menu

The following table provides an overview of the *View* menu.

<table>
<thead>
<tr>
<th>Item [Shortcut]</th>
<th>Remarks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Constant layout [Ctrl+1]</td>
<td>If selected, the Windows input focus will be set on the <em>Constant Layout area</em>. If the <em>Constant Layout</em> is not visible it will be brought to front.</td>
</tr>
<tr>
<td>Status message area [Ctrl+2]</td>
<td>If selected, the Windows input focus will be set on the <em>Status Message area</em>.</td>
</tr>
</tbody>
</table>
### 4.1. The User Interface In Configuration Mode

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Layout area [Ctrl+3]</td>
<td>If selected, the Windows input focus will be set on the Layout area. The first Layout is selected. To switch to another Layout use the (left and right) arrow keys of your keyboard.</td>
</tr>
<tr>
<td>Configuration bar [Ctrl+4]</td>
<td>If selected, the Windows input focus will be set on the Configuration Bar. If the Configuration Bar is not visible it will be brought to front.</td>
</tr>
<tr>
<td>HMI Control bar [Ctrl+5]</td>
<td>If selected, the Windows input focus will be set on the HMI Control bar. This feature is not implemented yet.</td>
</tr>
<tr>
<td>Property sheet [Ctrl+6]</td>
<td>If selected, the Windows input focus will be set on the Property Sheet. If the Property Sheet is not visible it will be brought to front.</td>
</tr>
<tr>
<td>Show toolbar</td>
<td>If checked, the Monaco Toolbar will be displayed. The status is shown by a check mark in front of the item. For more information see chapter Tool Bar.</td>
</tr>
<tr>
<td>Show status bar</td>
<td>If checked, the Monaco Status Bar will be displayed. The status is shown by a check mark in front of the item. For more information see chapter Status Bar. This feature is not implemented yet.</td>
</tr>
<tr>
<td>Show status message area</td>
<td>If checked, the Monaco Status Message Area will be displayed. The status is shown by a check mark in front of the item. For more information see chapter Status Message Area.</td>
</tr>
<tr>
<td>Show configuration bar</td>
<td>If checked, the Monaco Configuration Bar will be displayed. The status is shown by a check mark in front of the item. For more information see chapter Configuration Bar.</td>
</tr>
<tr>
<td>Show HMI Control bar</td>
<td>If checked, the HMI Control bar bar will be displayed.. This feature is not implemented yet.</td>
</tr>
<tr>
<td>Show property sheet</td>
<td>If checked, the Monaco Property Sheet will be displayed. The status is shown by a check mark in front of the item. For more information see chapter Property Sheet.</td>
</tr>
</tbody>
</table>
4.1. The User Interface In Configuration Mode

<table>
<thead>
<tr>
<th>Clear output windows</th>
<th>If selected, the content of all output windows will be cleared.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show debug window</td>
<td>If selected, the debug window will be displayed.</td>
</tr>
</tbody>
</table>

### 4.1.1.4 Configuration Menu

The following table provides an overview of the **Configuration** menu.

<table>
<thead>
<tr>
<th>Item [Shortcut]</th>
<th>Remarks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Execution Mode [CTRL+F4]</td>
<td>Switches Monaco to Execution Mode</td>
</tr>
</tbody>
</table>
| Show Constant Layout | If checked, the Constant Layout will be displayed.  
The status is shown by a check mark in front of the item.  
For more information see chapter **The User Interface In Configuration Mode**. |
| Show service tree | Displays the Service Tree)  
The status is shown by a check mark in front of the item.  
More information about the Service Tree you will find in the chapter **Service Tree**. |
| Add layout | Adds a new layout to the workspace.  
For more information see chapter **Setting Up Layouts**. |
| Sequence order: Move Up [CTRL+Up]  
Move Down [CTRL+Down] | The sequence order of the Monaco Layouts defines the order in which the Layouts are shown in the tab control of the Layout area.  
The sequence order for HMI Controls defines the order in which the HMI Controls are activated.  
The place of a selected Layout or HMI Control in the sequence can be changed using the **Sequence Order** item and its subitems **Move up** and **Move down**.  
This option is disabled if neither a Layout nor an HMI Control is currently selected.  
The current Sequence Order is displayed in the **Configuration Bar**. |
4.1. The User Interface In Configuration Mode

<table>
<thead>
<tr>
<th>Configure layout properties</th>
<th>Displays the <em>Layout properties</em> dialog of the current Layout.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td><img src="image" alt="Layout Properties" /> In the field <em>Title</em> the name of the Layout can be edited.</td>
</tr>
</tbody>
</table>
4.1. The User Interface In Configuration Mode

| Add HMI Control | Adds an HMI Control to the current Layout. The *Add HMI Control* dialog will open. Select an HMI Control from the list. Press OK to insert the HMI Control. |

![Add HMI Control](image.png)

The selected HMI Control is inserted at the end of the HMI Control sequence of the currently selected Layout. The size, position, name and other properties of the HMI Control can be changed later using the *HMI Control Properties* dialog. This dialog can be accessed using the *Configure HMI Control* item of the *Configuration* menu. See also chapter Property Sheet and Arranging HMI Controls.
4.1. The User Interface In Configuration Mode

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Configure HMI Control</td>
<td>Displays the <em>HMI Control Properties</em> dialog of the selected HMI Control.</td>
</tr>
<tr>
<td>Configure HMI Control execution mode behavior</td>
<td>Opens the Configurator of the selected HMI Control.</td>
</tr>
<tr>
<td>Configure snapshot</td>
<td>Displays the <em>Snapshot configuration</em> dialog. This dialog is used to manage the Snapshot files. For more information see chapter <em>Snapshots</em>.</td>
</tr>
</tbody>
</table>
Configure workspace

Displays the Workspace Options dialog.

- **Start Options**

  If *Start automatically after loading* is checked the execution of the Monaco workspace is started automatically after loading. When the checkbox is disabled the Monaco workspace has to be started manually after loading using the *Start* button from the Toolbar or the *Start* menu item in the *Execution* menu.

  There are two different start options for Layouts in the Layout area:

  *Start all Layouts*: The execution of all Layouts is started at the same time.

  *Start only visible Layout*: Only the Layout that is actually selected will be started.

  If *Start Instruments automatically* is checked HMI Controls from type Instrument are started automatically after loading. (see chapter HMI Control Graphical Instrument for further information).

- **Layout**

  There are two options available

  *Show Tabs*: The Layouts are shown as tabs and the title of each Layout is shown as the tab header.

  *Show Menu*: Only the selected (active) Layout will be shown in the Layout Area. Each Layout has an entry in the Menu Bar.
4.1. The User Interface In Configuration Mode

Configure common properties...
 Displays the Common Properties Configurator dialog which allows modifying the common properties of all HMI Control instances of a Workspace. For more information see chapter Setting Common HMI Control Properties

Configure data server...
 Displays the Data Server Configurator dialog. The Data Server provides request and response data for the HMI Controls from type Instrument. For more details about the data server and its configuration please refer to chapter Configuration of the Data Server.

4.1.1.5 Tools Menu
The following table provides an overview of the Tools menu.

<table>
<thead>
<tr>
<th>Item [Shortcut]</th>
<th>Remarks</th>
</tr>
</thead>
</table>
4.1. The User Interface In Configuration Mode

<table>
<thead>
<tr>
<th>Configure column handling...</th>
<th>Opens a dialog to configure the Column Handling in Execution Mode.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td><img src="image" alt="Configure Column Handling" /></td>
</tr>
</tbody>
</table>

The setting affects all HMI Controls with lists except the Bus Trace and Symbolic Trace HMI Controls.

There are two options available:

Absolute: The size of every column can be arranged without affecting the neighbor columns. If columns get out of the visible area of the list a scroll bar will appear.

Relative: All columns are always in the visible area of the list. If the size of one column is changed the neighbor column to the right will also change its size in order to fit in the visible area of the list.

<table>
<thead>
<tr>
<th>Configure ECU sequence order...</th>
<th>Opens the ECU Sequence Order Configurator. This configurator is able to determine the order of the ECUs in which they are handled in sequences. This order is used by HMI Controls that have a Sequence Editor, e.g. Complete Vehicle Coding. See Setting the ECU Sequence Order.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>This item is only available in Configuration Mode.</td>
</tr>
</tbody>
</table>

53
4.1. The User Interface In Configuration Mode

| Configure protocol parameter globally... | This option enables the user to set the Protocol Parameter globally for each protocol which is part of the project. It is only available when the Execution Mode is in state stopped. For more information see Global Protocol Parameter Settings. |
| Analyzer | Starts the DTS Analyzer, a tool to display trace files and snapshots. |
| Database Differ | Starts the DTS Database Differ, a tool to compare two Venice databases. |
| OTX Studio | Starts the OTX Editor, a tool to develop OTX scripts. |
| VRX Differ | Starts the VRX Editor, a tool to compare two VRX reports. |
| Software Station | Starts the Daimler Software Station |
| Options... | Opens a dialog to configure the Debug Trace. If the Options Function is selected from the Tools menu, the dialog window Options is shown. This dialog configures the debug trace file. This trace file collects all data generated by activities of the HMI Control during runtime. The trace file can be helpful e.g. if errors occur during communication with an ECU. When the check box Enable debug trace is activated, a name for the trace file may be entered in the field Debug trace file name. The display field Debug trace path shows the corresponding path of the trace file. 
**Note:** The path cannot be changed |

### 4.1.1.6 Help Menu

The following table provides an overview of the Help menu.

<table>
<thead>
<tr>
<th>Item [Shortcut]</th>
<th>Remarks</th>
</tr>
</thead>
<tbody>
<tr>
<td>DTS Monaco help [F1]</td>
<td>Opens the DTS Monaco integrated help system.</td>
</tr>
</tbody>
</table>
4.1. The User Interface In Configuration Mode

Support
 Provides information required by Softing support. Please copy and paste the content of this dialog to your problem description, when you contact Softing Support by email.

About DTS Monaco...
 Opens the About dialog containing information about DTS Monaco, such as details of the version and supplier.

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Action</th>
<th>Remarks</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="New" /></td>
<td>New</td>
<td>File Menu - New</td>
</tr>
<tr>
<td><img src="image" alt="Open project" /></td>
<td>Open project</td>
<td>File Menu - Open</td>
</tr>
<tr>
<td><img src="image" alt="Open workspace" /></td>
<td>Open workspace</td>
<td>File Menu - Open Configuration</td>
</tr>
<tr>
<td><img src="image" alt="Save" /></td>
<td>Save</td>
<td>File Menu - Save</td>
</tr>
<tr>
<td><img src="image" alt="Cut" /></td>
<td>Cut</td>
<td>Edit Menu - Cut</td>
</tr>
<tr>
<td><img src="image" alt="Copy" /></td>
<td>Copy</td>
<td>Edit Menu - Copy</td>
</tr>
<tr>
<td><img src="image" alt="Paste" /></td>
<td>Paste</td>
<td>Edit Menu - Paste</td>
</tr>
<tr>
<td><img src="image" alt="Delete" /></td>
<td>Delete</td>
<td>Edit Menu - Delete</td>
</tr>
<tr>
<td><img src="image" alt="Toggle Constant Layout" /></td>
<td>Toggle Constant Layout</td>
<td>View Menu - Toggle Constant Layout</td>
</tr>
</tbody>
</table>
4.1.3 Configuration Bar

The Configuration Bar shows the currently loaded Monaco workspace configuration as a tree structure.
It can be used as a browser for selecting and manipulating configuration items (Views, Lay-
outs and HMI Controls).

To display the Configuration Bar select Show configuration bar from the View menu.
The Configuration Bar dialog will open.
4.1. The User Interface In Configuration Mode

The tree shows two main branches:

- Static Views
- Layouts

**Static Views Branch**

The *Static Views* contains the Status Message Area and the Constant Layout Area. It is not supported to add Layouts in the *Static Views* branch.

The *Status message area* item in the *Configuration Bar* offers a context menu. Select *Configure...* from the context menu to open the configuration dialog.

For the *Constant Layout* item a context menu is available:

- *Add HMI Control...*: Add a HMI Control to the selected Layout
- *Configure layout properties...*: Change the title name of the Layout
4.1. The User Interface In Configuration Mode

- **Copy**: Copy the selected Layout to the Clipboard
- **Paste**: Paste HMI Controls from the Clipboard to the selected Layout

**Layouts Branch**

The individual Layouts are displayed as branches of the Layout branch. For each layout a context menu is available:

- **Add HMI Control...**: Add a HMI Control to the selected Layout
- **Configure layout properties...**: Change the title name of the Layout
- **Copy**: Copy the selected Layout to the Clipboard
- **Paste**: Paste HMI Controls from the Clipboard to the selected Layout
- **Delete**: Remove the selected Layout from the workspace

The HMI Controls of a Layout are displayed as branches of the individual Layout. For each HMI Control a context menu is available:

- **Configure HMI Control execution mode behavior...**: Open the Configurator of the HMI Control
- **Configure HMI Control...**: Open the property Sheet with the HMI Control Properties
- **Copy**: Cut the selected HMI Control from the Layout to the Clipboard
- **Copy**: Copy the selected HMI Control to the Clipboard
- **Paste**: Paste HMI Controls from the Clipboard to the selected Layout
- **Delete**: Remove the selected HMI Control from the Layout
4.1. The User Interface In Configuration Mode

Layouts or HMI Controls can be freely moved in the Configuration Bar using Drag and Drop.

The order of HMI Controls in the Configuration Bar determines their startup order. An error may occur if one HMI Control needs to start after e.g. an initialization from another HMI Control.

Layouts can also be copied from one workspace to another using Copy. Monaco must not be closed in between.

4.1.4 Property Sheet

The Property Sheet is a configuration dialog of a Layout or an HMI Control.

Depending on the current selection the property pages of a Layout or of a HMI Control are displayed.

To open the Property Sheet check Show property sheet in the View menu.

Layout Properties

When a Layout is selected, the property pages of the Layout are displayed in the Property Sheet dialog.
4.1. The User Interface In Configuration Mode

As Layout Properties only the Layout title is available.

**HMI Control Properties**

When an HMI Control is selected, the property pages of the HMI Control are displayed in the Property Sheet dialog.

The General tab enables and configures Snapshots.
4.2. Creating a new Workspace

The Position and Size tab shows the position and size of the HMI Control relative to the Layout.

The third tab shows configuration options specific to the selected HMI Control. The options available are a subset of the options available in the HMI Control Configurator. The tab allows easy access to frequently used configuration items.

4.2 Creating a new Workspace

To create a new Monaco Workspace you must have a Interface Designer license option, because you have to open Monaco in Configuration Mode.

Select New... from the File menu or select Create a new workspace in the Start Page.
4.2. Creating a new Workspace

The following Template selection dialog will open.

**Template Selection**

```
[Image of Template Selection dialog]
```

Start with a completely empty workspace or select one of the provided templates.

The following templates are available:

- **Communication Basics**
  This will open a workspace with a Constant Layout containing a Bus Trace and a Symbolic Trace HMI Control. There will be two Layouts, one with a Diagnostic Services HMI Control and the other with an OTX Script Console HMI Control.

- **Flash Programming**
  This will open a workspace with a Constant Layout containing a Bus Trace and a Symbolic Trace HMI Control. There will be two Layouts, one with a Flash Programming HMI Control and the other with a Diagnostic Services HMI Control.

- **OBD Development**
  This will open a workspace with a Constant Layout containing two Bus Trace HMI Controls, one for CAN the other for K-Line. There will be three Layouts, one with an OBD HMI Control, the second with a Diagnostic Services HMI Control and the last with two Symbolic Trace HMI Controls, one for CAN the other for K-Line.

- **OBD**
  This will open a workspace with a Constant Layout containing a Bus Trace and a Symbolic Trace HMI Control (for CAN). There will be two Layouts, one with an OBD HMI Control and the other with a Diagnostic Services HMI Control.
4.3. Creating a new Workspace Template

When you are in Configuration Mode you may extend or adapt these templates to your needs. Click Next> to go on to the next step.

**Project Selection**

The next step will ask you to select a DTS project that you want to use with your new workspace.

Select the Project in the list to the left. When the Project has been selected the available Vehicle Information will be show in the list to the right. After the Vehicle Information has been selected it will be loaded and the Finish button will be activated. The Finish button of the dialog stays disabled until the user has selected both a DTS Project and a Vehicle Information. Click Finish to start Monaco in Configuration Mode with the selected template loaded.

### 4.3 Creating a new Workspace Template

For quick and easy access to the diagnostic functionality of the HMI Controls, Monaco supports predefined configurations, that can be used with any DTS project.

A template is a predefined workspace that may be used as a base workspace configuration for other DTS projects.

Unlike Workspace files, Workspace Templates are independent of a DTS project.

**Creating a Workspace Template File**

In Configuration Mode, the currently opened Workspace configuration can also be stored as a Workspace Template file using Save As Template... in the File menu (see chapter Save As Template...).
This only makes sense if the current configuration is not dependent on the selected DTS project and Vehicle Information. The Monaco Framework does not check whether such dependencies exist and stores the configuration as a Workspace Template even if the configuration does not work with other DTS projects or Vehicle Information. It is the responsibility of the template author to avoid such dependencies.

To create an empty Workspace Template or to select an existing one choose New from the File menu (see chapter New).

**Storing a Workspace Template File**

The Workspace Templates are not associated to a special DTS project and are therefore not stored within a DTS project subdirectory.

The configuration templates are always located in the subdirectory \Program Files\Softing\DTS_V8\Version\hmt of the corresponding DTS 8 installation path.

Monaco Workspace Template files have the extension mnt.

There are some Workspace Template files delivered with DTS-Monaco, that contain Layouts and HMI Controls of different types. Take a look at chapter The Monaco HMI Controls for detailed information about these HMI Controls.

**4.4 Setting Up Layouts**

A Layout in Monaco is an area that contains one or more HMI Controls.
In Configuration Mode HMI Controls can be arranged freely in this area.

Different Layouts can be active at the same time. The user can easily change the Layout by clicking on another tab. So a user may perform the first step of a task in the first Layout and the switch to the next Layout in order to perform the next steps that may require different HMI Controls. Switching to other Layouts does not affect communication with an ECU in *Execution Mode*.

There are two types of Monaco Layouts:

- **Constant Layout** The Constant Layout Area is a layout that is displayed or hidden as required by the user.

  When the Constant Layout is active it will be always visible.

  It is not supported to add Layouts to the Constant Layout area. Only one Layout is supported.

- **Layout in the Layout Area** The Layout Area can host one or more Layouts, that may be switched by tabs.

The following operations are supported by Monaco Layouts:

**Adding a Layout to the Workspace**

A new Layout is added to the workspace using *Add layout...* from the *Configuration* menu. Please note, a new Layout can only be added to the Layout Area. The Constant Layout does not support adding additional Layouts.

The *Add Layout* dialog will open.

![Add Layout Dialog](image)

Enter a name for your new Layout. This name will be shown on the tab of the Layout. The name of the Layout may be changed later using *Configure layout properties...* from the *Configuration* menu.
Press OK to insert the Layout.

The new Layout is inserted at the end of the Layout sequence. It is empty showing a grid, visible and already selected.

**Selecting a Layout**

A Layout can either be selected by clicking on the corresponding tab of the Layout Area or by using the Configuration Bar (see chapter Configuration Bar).

Selecting a Layout results in the following:

- The selected Layout becomes visible in the Layout Area, which means that the selected Layout is displayed in the foreground.
- The Property Sheet dialog provides the property pages of the selected Layout.
- The Layout menu is made available, i.e. its functions are enabled.
- The corresponding Layout tree item of the Configuration Bar is also selected.
- An HMI Control currently selected is deselected.

It is not possible to select multiple Layouts.

**Deleting a Layout**

A Layout can only be deleted if it is selected.

To delete a Layout use one of the following options:

- Press Ctrl + Del on the keyboard.
- Select Delete from the Edit menu.
- Select Delete from the context menu of the selected layout in the Configuration Bar

All HMI Controls that are contained in the Layout will be deleted too.

The Layout is deleted irrevocably, there is no Undo function. For this reason the user is asked to confirm deleting the Layout.

**Duplicating Layouts**

A Layout can be duplicated inside the Layout Area or even between Constant Layout and Layout area.

- The Copy command will copy a selected Layout and all its HMI Controls to the Clipboard.
4.5. Setting up HMI Controls

- The *Paste* command will insert a Layout and all its HMI Controls from the Clipboard to the currently selected Layout Area or Constant Layout Area.

To Copy or Paste a Layout use one of the following options:
- Select Copy or Paste from the *Edit* menu.
- Press Ctrl+C for Copy or Ctrl-V for Paste on the keyboard.
- Select the Copy or Paste button from the Monaco Tool Bar.
- Select the Layout by clicking on a free area (where the grid is visible) and open the context menu. Select Copy or Paste from the context menu.
- Select the Layout in the *Configuration Bar* and open the context menu. Select Copy or Paste from the context menu.

**Changing the Layout Sequence Order**

The order for Layouts defines the order in which the Layouts are shown in the tab control of the Layout area.

This order will also be used for activation of Layout and their HMI Controls. The order can be changed by selecting *Sequence Order* from the *Configuration* menu. This is used to move the Layout currently selected up or down within the order. The order can also be changed with help of the *Configuration Bar* (see chapter *Configuration Bar*) using Drag and Drop.

After loading a configuration, the first Layout in the Layout sequence order is always shown.

**4.5 Setting up HMI Controls**

HMI Controls are the elements of the Monaco user interface that provide the functionality for the communication with vehicle systems.

The following operations are supported by Monaco HMI Controls:
- Adding an HMI Control to a Layout
- Selecting an HMI Control
- Configuration of HMI Controls
- Arranging HMI Controls
4.5. Setting up HMI Controls

- Duplicating and Moving HMI Controls
- Changing the HMI Control Sequence Order
- Deleting an HMI Control

4.5.1 Adding an HMI Control to a Layout

Use one of the following options to add an HMI Control to the current Layout:

- Select a Layout in the Layout area where you want to add the HMI Control. Click Add HMI Control... in the Configuration menu.

- Right-click into the free area of a Layout to open the context menu of the Layout. Select Add HMI Control....

- Select Add HMI Control... from the context menu of the selected layout in the Configuration Bar.

The Add HMI Control dialog will open. Select an HMI Control from the list. Press OK to insert the HMI Control.
4.5. Setting up HMI Controls

When an HMI Control is added, Monaco performs the following actions:

- The HMI Control is initialized with a default configuration.
- The HMI Control is added to the selected Layout or to the constant Layout with a default position and size.

The selected HMI Control is inserted at the end of the HMI Control sequence of the currently selected Layout.
4.5. Setting up HMI Controls

The new HMI Control is visible and selected.

The size, position, name and other properties of the HMI Control can be changed later using the Property sheet **HMI Control Properties**.

This dialog can be accessed using the **Configure HMI Control** item of the **Configuration** menu. See also chapter **Property Sheet**.

![HMI Control Properties dialog](image)

4.5.2 Selecting an HMI Control

An HMI Control can either be selected by clicking on the HMI Control itself or by using the **Configuration Bar**.

Selecting an HMI Control results in the following:

- The selected HMI Control becomes visible. If the HMI Control is part of a Layout in the Layout Area, the Layout will be brought to the foreground. If an HMI Control of the **Constant Layout** is selected, this Layout will be displayed).
- The selected HMI Control will be surrounded with a tracker rectangle.
- The Property Sheet **HMI Control Properties** of the selected HMI Control will be available. (Select **Configure HMI Control** item of the **Configuration** menu to show the Property Sheet)
- The corresponding HMI Control in the tree of the **Configuration Bar** is selected.
- A Layout currently selected will be deselected.

Selecting multiple HMI Controls is not supported.
4.5. Setting up HMI Controls

4.5.3 Configuration of HMI Controls

For configuration of an HMI Control the following options are available:

- **Configuration of HMI Control Properties:**
  
  When an HMI Control is selected, the property pages of the HMI Control are displayed in the Property Sheet dialog.
  
  To open the Property Sheet of an HMI Control select it and choose *Configure HMI Control...* from the *Configuration* menu or from the context menu of the HMI Control. For more information see chapter *Property Sheet*.

- **HMI Control Configurator:**

  The HMI Control Configurator offers options to control the behavior of the HMI Control in Execution Mode.
  
  To open the HMI Control select it and choose *Configure HMI Control execution mode behavior...* from the *Configuration* menu or from the context menu of the HMI Control.
  
  The HMI Control Configurator offers one or more tabs with grouped configuration options.

At least a Configurator offers the Common Settings tab. Other tabs may provide Filter settings or the configuration of Sequences and Services.
4.5.4 Arranging HMI Controls

Use the mouse to change the arrangement of HMI Controls within a Layout. The selected HMI Control will be surrounded by a tracker rectangle.

The tracker rectangle has eight resize handles for controlling the shape and size of the HMI Control.

Move the mouse pointer over a tracker rectangle and press the left mouse button to resize the HMI Control.

The position of the selected HMI Control can be changed by moving the mouse while keeping the left mouse button pressed down.

By default the position of an HMI Control is changed according to the grid. To change the position independently of the grid press the ALT key during this action.

The position and size of the HMI Controls are limited by the size of the Layout. An HMI Control cannot be moved outside this area and the size of an HMI Control cannot exceed these limits.

It is, however, possible for the user to arrange HMI Controls overlapping other HMI Controls. The Monaco Framework does not prevent this and it is the responsibility of the configuration
4.5. Setting up HMI Controls

author to avoid overlapping HMI Controls.

4.5.5 Duplicating and Moving HMI Controls

An HMI Control can be duplicated or moved inside a Layout or between different Layouts (even between Constant Layout and Layout area).

- The *Copy* command will copy a selected HMI Control to the Clipboard.
- The *Cut* command will remove a selected HMI Control from the Layout and copy it to the Clipboard.
- The *Paste* command will insert an HMI Control from the Clipboard to the currently selected Layout.

To Copy, Cut or Paste a HMI Control use one of the following options:

- Select Copy, Cut or Paste from the *Edit* menu.
- Press Ctrl+C for Copy, Ctrl-X for Cut or Ctrl-V for Paste on the keyboard.
- Select the Copy, Cut or Paste button from the Monaco Tool Bar.
- Select the HMI Control and open the context menu. Select Copy, Cut or Paste from the context menu.
- Select the HMI Control in the *Configuration Bar* and open the context menu. Select Copy, Cut or Paste from the context menu.

4.5.6 Changing the HMI Control Sequence Order

The order for HMI Controls defines the order in which the HMI Controls are activated when Monaco execution is started.

The order is displayed in the *Configuration Bar* and can be changed by selecting *Sequence Order* from the *Configuration* menu. This will move the HMI Control currently selected up or down within the order.

The order can also be changed with help of the *Configuration Bar* using Drag and Drop.
4.5.7 Deleting an HMI Control

An HMI Control can only be deleted if it is currently selected.

To delete a HMI Control use one of the following options:

- Press Ctrl+Del on the keyboard.
- Select Delete from the Edit menu.
- Select Delete from the context menu of the selected HMI Control in the Configuration Bar.

The HMI Control is deleted irrevocably. There is no Undo function.

5 Working with HMI Controls

HMI Controls are the elements of the Monaco user interface that provide the functionality for the communication with vehicle systems.

For a list of all HMI Controls see chapter The Monaco HMI Controls.

Setting Up Layouts and HMI Controls

Many HMI Controls use similar methods and dialogs in their Configurator. Please see chapter Common Configuration Settings.

To set common properties for all HMI Controls in a Workspace use the Common Properties Configurator.

Working with HMI Controls in Execution Mode

Many HMI Controls offer a tree with Logical Links. The icon in front of a Logical Link shows its State.

5.1 Logical Link States

The Logical Links in a HMI Control are displayed with a status icon showing the current state of the link.

The state of a Logical Link is visualized by the following icons.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Remarks</th>
</tr>
</thead>
</table>

74
5.1. Logical Link States

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Protocol Closed" /></td>
<td>The LogicalLink of type Protocol is in the state <em>closed</em></td>
</tr>
<tr>
<td><img src="image" alt="Protocol Online" /></td>
<td>The LogicalLink of type Protocol is in the state <em>online</em></td>
</tr>
<tr>
<td><img src="image" alt="Protocol Communication" /></td>
<td>The LogicalLink of type Protocol is in the state <em>communication</em></td>
</tr>
<tr>
<td><img src="image" alt="Functional Group Closed" /></td>
<td>The LogicalLink of type Functional Group is in the state <em>closed</em></td>
</tr>
<tr>
<td><img src="image" alt="Functional Group Online" /></td>
<td>The LogicalLink of type Functional Group is in the state <em>online</em></td>
</tr>
<tr>
<td><img src="image" alt="Functional Group Communication" /></td>
<td>The LogicalLink of type Functional Group is in the state <em>communication</em></td>
</tr>
<tr>
<td><img src="image" alt="Base Variant Closed" /></td>
<td>The LogicalLink of type Base Variant is in the state <em>closed</em></td>
</tr>
<tr>
<td><img src="image" alt="Base Variant Online" /></td>
<td>The LogicalLink of type Base Variant is in the state <em>online</em></td>
</tr>
<tr>
<td><img src="image" alt="Base Variant Communication" /></td>
<td>The LogicalLink of type Base Variant is in the state <em>communication</em></td>
</tr>
<tr>
<td><img src="image" alt="Variant Closed" /></td>
<td>The LogicalLink of type Variant is in the state <em>closed</em></td>
</tr>
<tr>
<td><img src="image" alt="Variant Online" /></td>
<td>The LogicalLink of type Variant is in the state <em>online</em></td>
</tr>
<tr>
<td><img src="image" alt="Variant Communication" /></td>
<td>The LogicalLink of type Variant is in the state <em>communication</em></td>
</tr>
</tbody>
</table>

Logical Links in state *offline* are not displayed.

If an error occurred the icon will get a red cross-mark overlaid.

**Changing the state of a Logical Link**

Some HMI Controls (e.g. Logical Link List, Diagnostic Services, Flash Programming) provide a context menu when you right-click the Logical Link.

This menu offers the following items:

<table>
<thead>
<tr>
<th>Menu Item</th>
<th>Remarks</th>
</tr>
</thead>
</table>

75
### 5.1. Logical Link States

| **Open Logical Link** | When a LogicalLink is opened, it will get into the state *online*. In this state no diagnostic session is established, but some services may be executed. No tester present messages will be sent to the ECU. There is no Diagnostic Session entered in the ECU, the ECU is in the default session.

In case of a K-LINE Protocol it is not possible to communicate with several ECU in parallel. Therefore only one Logical Link can be opened.

A diagnostic hardware interface can only process a limited count of Logical Links. If the limit is reached, a Logical Link has to be closed before a new one can be opened. |
| **Start Communication** | When the *Start Communication* command is applied to a Logical Link in the state *closed* or *online*, its state will change to *communication*.

In case of a Logical Link to a K-Line ECU the communication will be established by performing a Bus Initialization (e.g. 5 Baud Init or Fast init).

The communication to the ECU is started by executing the Start Communication service that will enter a Diagnostic Session in the ECU. Additionally a Variant Identification and Selection will be performed. After that the TesterPresent Messages will be sent until the Logical Link state changes back to *online* or *closed*. |
| **Stop Communication** | The command *Stop Communication* terminates the Diagnostic Session with the ECU by sending out the Stop Communication Service. The TesterPresent messages will be stopped. The Logical Link state changes to *online*. Also in all other HMI controls that are in communication with the same ECU their Logical Link will also change to the state *online*. |
| **Close Logical Link** | If the Logical Link gets closed the TesterPresent messages will be stopped. A Stop Communication service will not be sent. The Logical Link state changes back to *closed*. |

The HMI Control **Logical Link List** is designed to visualize *Logical Links* and their states as well as to change these states.
5.2 Setting Common Properties for all HMI Controls

Every HMI Control has a set of properties, which can be modified by the user to configure the Layout and the behavior of the HMI Control. A lot of these properties are specialized and make only sense for a certain kind of HMI Control, but there are some common properties that will be used in all (or almost all) HMI Controls.

The user can modify the properties of an HMI Control instance by using the Configurator of the HMI Control. This is a good way to configure different HMI Control instances with individual property values.

But it is very inconvenient for the user to set a common property of all HMI Control instances to the same value because the configuration must be done for each HMI Control instance individually. The HMI Controls support a mechanism to enable applications (Monaco or OEM applications) to provide a common dialog where the user can modify the common properties of all HMI Control instances of a configuration.

These settings can than be overwritten for every single HMI Control using its Configurator. The configuration of HMI Controls and the meaning of the properties are explained in chapter The Monaco HMI Controls.

The Common Properties Configurator has four different tabs on the left side.

1. Common Settings:
   - Show Frame [true/false]: Switches visualization of a border frame between on and off.
   - (Show LongNames [true/false]: Switches visualization of LongName between on and off.
   - Show Services) [true/false]: Switches visualization of Diagnostic Services between on and off.
   - Show FunctionalClasses [true/false]: Switches visualization of Functional Classes (including Services) between on and off.
5.3. Common Configuration Options

- **Show ServiceId [true/false]**: Switches visualization of the Service ID. Also the order of services will change between alphabetically and numerically.
- **Show LinkName [true/false]**: Switches visualization of the Link Name.
- **Auto Start Communication [false/true]**: The communication starts automatically, if the communication has not been started already. If the service belongs to a Base Variant a VariantIdentificationAndSelection ComPrimitive will be executed.

2. Filters:

   On the second tab the settings for filters can be defined globally. For more details about filters please see chapter Filters.

3. Raw / Hex Services:

   On this tab the configuration of HexServices and RawServices is centralized. Inside the Monaco configuration different Raw- and Hexservices can be defined. The configuration of HexServices and RawServices is explained in chapter Services ComPrimitives and Sequences.

4. ProtocolParameterSet Services:

   On this tab the configuration of ProtocolParameterSet is centralized. One ProtocolParameterSet includes a defined set of ProtocolParameter. The configuration is explained in chapter Services ComPrimitives and Sequences

### 5.3 Common Configuration Options

The Configurator can configure every HMI control. There is some shared functionality, which applies to every HMI control concerning configuring them. Shared functionality means that there are identical approaches, for example to change a value of a property of an HMI control, or structures which can be found in a couple of configurations of different HMI controls. This shared functionality will be described in the following chapters.

All screenshots, which are shown in the following chapters, are related to the HMIControl DiagnosticServices concerning to the example DTSPProject which can be found by the path: ProgramData\Softing\Diagnostic Tool Set\Version\DTSPProjects in the installation directory of DTS 8.

### 5.3.1 Structure of an HMI Control Configurator

A dialog window of a Configurator has a mostly similar structure for all HMI Controls. This dialog window can configure the appropriate HMI Control and the Configurator dialog window
5.3. Common Configuration Options

itself. The Figure below shows an example for a Configurator dialog window. In this case it is the DiagnosticServices - Configurator dialog window of the HMIcontrol DiagnosticServices.

A Configurator dialog window consists of one or two tab controls, which contain one or more tabs. The number of tab controls and their tabs depend on the HMI Control the dialog window belongs to. In case of the Figure above there are two tab controls, which contain on the left hand side 6 tabs and on the right hand side 3 tabs. In the case of entering wrong entries in the Configurator error messages are shown in the output window on the bottom of the Configurator. With the Clear button the output window can be cleared from occurred messages. A click on this button hides the visible line (it does not delete it from the combo box). A second click on this button deletes all entries from the combo box. The Table below gives an overview about the functionality of the buttons, which are common to every Configurator of an HMI Control.

<table>
<thead>
<tr>
<th>Button</th>
<th>Functionality</th>
</tr>
</thead>
<tbody>
<tr>
<td>[OK]</td>
<td>Changes and creations (e.g. Sequences), which were done in the Configurator, are applied and the Configurator is closed.</td>
</tr>
<tr>
<td>[Cancel]</td>
<td>Closes the Configurator without applying changes or new creations.</td>
</tr>
<tr>
<td>[Help]</td>
<td>Opens the entry in the help which relates to the appropriate HMI Control.</td>
</tr>
<tr>
<td><img src="button.png" alt="" /></td>
<td>Clears the output window on the right hand side of this button.</td>
</tr>
</tbody>
</table>
5.3. Common Configuration Options

Some tabs are provided for several Configurators of HMI Controls. This tabs and their handling are described in the following chapters.

5.3.2 Common Settings

Structure
The Figure below shows the tab Common Settings of the Configurator and the user interface of the HMI Control DiagnosticServices. The tab Common Settings consists of a list box with two columns. The first column consists of Properties. The Properties are structured in different groups. The number of the provided groups is dependent on the corresponding HMI Control. The names of the different groups are written in blue color.

![Common Settings Tab](Image)

The Property group General consists of Properties, which relate to the configuration of the Configurator and the occurrence of these properties in the graphical user interface of the appropriate HMI Control. For example the Property Show LogicalLinks on Variants relates to the structure of the LogicalLink Filter provided by the tab Filters of the Configurator and the list box Database of the user interface.

All other Property groups which are listed beneath the Property group General relate to the user interface of the corresponding HMI Control. For example by the Property group Transmit Button the button [Transmit] can be configured by the Properties caption and run caption.

The second column of the tab Common Settings consists of the possible values of each Property. After installation the default value for each Property is shown. Default values of Properties which can not be changed by the Configurator are represented by letters in gray color. These values can be changed by the tool window Property Sheet.

If the setting for a property can be done with the Common Properties - Configurator see chapter Configuration Menu - Common Properties there is an icons from Table below appearing on the left side of the appropriate property cell, which informs the user either a common property is used, or a property is overwritten for the appropriate HMI Control.
5.3. Common Configuration Options

<table>
<thead>
<tr>
<th>Icon</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Icon" /></td>
<td>The setting from the <em>Common Properties - Configurator</em> is used for this property.</td>
</tr>
<tr>
<td><img src="image" alt="Icon" /></td>
<td>The setting from the <em>Common Properties - Configurator</em> is overwritten inside of this HMI Control.</td>
</tr>
</tbody>
</table>

To overwrite a value just execute a double click in the appropriate cell and change it. Now the common setting is not used for this HMI Control. If the property is overwritten, but the common setting shall be used again execute a right click over the appropriate cell in the HMI Configurator and choose the entry *Reset to common* from the appearing context menu.

**How to change the value of a Property**

If you want to change the value of a Property e.g. in the tab *Common Settings* the value of the Property *caption* of the Property group *Transmit Button*, follow the approach below:

1. Step:
   Select the appropriate Property by a double left mouse click.

2. Step:
   In the case of the Property *caption* the corresponding field of the column *Value* is activated. Now it is possible to change the caption of the Button *Transmit* (see Figure below). If another Property like *visible* of the Property group *Frequent Checkbox* is selected a pull down menu occurs. By this pull down menu the value can be changed. For example in the case of the Property *visible* from true to false. That means the checkbox *Frequent* will not be visible in the user interface any more.
5.3.3 Filters

Filters are provided for nearly every HMI Control, which can be inserted into the Monaco Framework, to ease the Configuration of HMI Controls. These filters avoid presenting more information than needed during Configuration or Execution Mode.
5.3. Common Configuration Options

5.3.3.1 Structure

The tab Filters is used to configure the contents of the tabs Services and ComPrimitives of the tab control of the right hand side of a Configurator, if they are provided. Furthermore the using of filters has effects on the user interface of the corresponding HMI Control.

The tab Filters consists of a list box with two columns. The first column consists of Properties. The Properties are structured in different groups. The number of the provided groups is dependent from the corresponding HMI Control. The names of the different groups are written in blue color (e.g. LogicalLink filter). The content of each Property group depends on the database which is part of the DTS project.

The second column consists of values of the corresponding Properties. The Figure below shows the tab Filters with the corresponding tab Services. In this case the default settings of the available filters are shown. That means the filters have the value off. Consequently the Properties of the filters are disabled because no filter is used.

The tab Services shows a list box which contains a tree. This tree consists of LogicalLinks (e.g. DiagCanV_zgw, EDICmost_1_CAN_1, etc), FunctionalClasses (e.g. dataTransmission, diagnosticManagement, etc) and DiagnosticServices (e.g. readDataByCommonID, readDataByLocalID, etc).

The tab ComPrimitives, whose caption is only shown in chapter How to activate a filter, shows also a tree which consists of the same LogicalLinks. The LogicalLinks contain the ComPrimitives. ComPrimitives do not belong to FunctionalClasses. Consequently the tree
of the tab **ComPrimitives** do not show them.

In general the tab **Filters** provides two kinds of filters. Both are described in the following paragraphs.

### 5.3.3.2 Using different filters

#### • LogicalLink filter

The user can determine if one, more or all LogicalLinks of the **database** window of a DTS project should be visible. The User can choose between **reject** and **pass**. If it is set to **reject** the LogicalLinks are not visible in the **database** window of the HMI Control. If it is set to **pass** the LogicalLinks are visible in the **database** window of the HMI Control.

#### • FunctionalClasses filter

The user can determine if one, more or all FunctionalClasses of the **database** window of a DTS project should be visible. The User can choose between **reject** and **pass**. If it is set to **reject** the FunctionalClasses are not visible in the **database** window of the HMI Control. If it is set to **pass** the FunctionalClasses are visible in the **database** window of the HMI Control.

### 5.3.3.3 FunctionalClasses Filters

With this filter the user can determine if one, more or all FunctionalClasses of a database of a DTS project should be visible **pass** or suppressed **reject** in the tab **Services** and in the user interface of some HMI Controls (e.g. list box **Database** of the user interface of the HMI Control).
5.3. Common Configuration Options

Control DiagnosticServices, see chapter How to activate a filter). The Figure below shows the tab Filters of the HMI Control DiagnosticServices related to the DTS project SystemTestPDUAPI. The filter FunctionalClasses is activated on. The value of the Property dataTransmission is set to reject, all the other remain pass. Consequently the tree of the tab Services consists of all FunctionalClasses except the dataTransmission (please compare with the figure of the chapter Structure). There are no changes of the data representation in the tab ComPrimitives, because ComPrimitives do not belong to any FunctionalClasses see chapter Services ComPrimitives and Sequences.

5.3.3.4 How to activate a filter

First of all the value of the Property group (LogicalLink filter or FunctionalClasses filter) has to be changed from off to on.

Please follow this approach:

- **Step 1:** Select the appropriate Property group by a double left mouse click.
- **Step 2:** Afterwards a pull down menu occurs in the appropriate line of the column Value. By this pull down menu the value can be changed from off to on. Confirm your entry by ENTER.
- **Step 3:** If this is done, all Properties of this filter are activated and their values change from pass to reject. The approach for changing the value of a Property is the same as described in step 1 (select Property) and step 2 (change the value).

Another way to change the value of a Property group or a Property is to use the context menu. If a Property group is selected then the current context menu will be available:
5.3. Common Configuration Options

If the filter is on, if a sub item of a filter is selected then the context menu will be shown:

If a multiple sub items of a filter are selected (e.g. by holding down Shift or Enter key while marking) then the next context menu will be shown:

Sub items from different filters can be selected as long as all the filters are on. If at least one of the filters is off, the menu will not be shown and the next error will be displayed in the errors combo in the configuration dialog.

When the selected items contain sub items of a filter but also a filter, the menu will not be shown and the next error will be displayed in the errors combo in the configuration dialog.
5.3. Common Configuration Options

The Figure below shows the user interface of the HMI Control DiagnosticServices. This is the resulting user interface after the changes described in chapters LogicalLink filter and FunctionalClasses filter. Have a look at the list box Database of this HMI Control. Only the LogicalLinks DiagCan and DiagCan, ExampleECU including FunctionalClasses and DiagnosticServices is displayed. All FunctionalClasses are displayed except the Functional-Class dataTransmission because it was rejected in chapter FunctionalClasses filter.

5.3.4 Services ComPrimitives and Sequences

This chapter deals with the relationship between the tabs Services, ComPrimitives and Sequences of the Configurator of an HMI Control. As in the chapters before the HMI Control DiagnosticServices in combination with the DTS project SystemTestPDUAPI is used as an example for the concrete description.

5.3.4.1 Structure

The structure of the three tabs is described in this chapter. The tab Services is only activated if one of the Sequence tabs (i.e. Sequence 1 to Sequence 4) is selected in the left tab control of the Configurator.
5.3. Common Configuration Options

The list box of the tab **Services** shows a tree. This tree consists of LogicalLinks (DiagCan and ExampleECU(DiagCan)), FunctionalClasses (e.g. dataTransmission, diagnosticManagement, etc) and DiagnosticServices (e.g. inputOutputControlByCommonId). The content of this list box depends on the Configuration of the tab **Common Settings** and the use of filters see chapters **Common Settings** and **Filters**. The naming of the LogicalLinks contains information of the inheritance of Protocols, Functional Groups, ECUBaseVariants and ECUVariants. Thus the following rules are valid:

- Protocol
- FunctionalGroup
- ECULinks
- VariantLinks

The tab **ComPrimitives** see figure below is only activated if one of the Sequence tabs (i.e. Sequence 1 to Sequence 4) is selected in the left tab control of the Configurator. The tab **ComPrimitives** shows also a tree which consists of the same LogicalLinks as the tab **Services**. The LogicalLinks contain the ComPrimitives. ComPrimitives do not belong to FunctionalClasses. Consequently the tree of tab **ComPrimitives** does not show them.

ComPrimitives provide general functionalities. They do not belong to any database, but are hard coded in the DTS 8 system (see chapter **ComPrimitives** for detailed information).
5.3. Common Configuration Options

The tab **Sequence 1** see figure above consists of a list with two columns. The first column shows the ShortName and the second one the corresponding LogicalLink of the added Services/ComPrimitives.

The table below gives an overview about the functionality of the buttons, which are used to create a Sequence.

<table>
<thead>
<tr>
<th>Button</th>
<th>Functionality of the buttons of the Sequence Configurator</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Folder" /></td>
<td>deletes the content of the currently selected Sequence tab (i.e. Sequence 1 to Sequence 4)</td>
</tr>
<tr>
<td><img src="image" alt="Left Arrow" /></td>
<td>adds a DiagnosticService or ComPrimitive to the list of the tab Services</td>
</tr>
<tr>
<td><img src="image" alt="Right Arrow" /></td>
<td>removes a DiagnosticService or ComPrimitive from the list of the tab Services</td>
</tr>
<tr>
<td><img src="image" alt="Up Arrow" /></td>
<td>moves a selected DiagnosticService or ComPrimitive up in the list of the tab Services (i.e. the selected Service/ComPrimitive changes its position with the one above)</td>
</tr>
<tr>
<td><img src="image" alt="Down Arrow" /></td>
<td>moves a selected DiagnosticService or ComPrimitive down within the list of the tab Services (i.e. the selected Service/ComPrimitive changes its position with the one beneath)</td>
</tr>
</tbody>
</table>
5.3. Common Configuration Options

5.3.4.2 ComPrimitives

A ComPrimitive is a command, which goes directly to the firmware of the hardware interface. A runtime ComPrimitive represents e.g. a state transition of a LogicalLink (e.g. GotoOnline) and real communication objects (e.g. StartCommunication). The table below provides an overview about the available ComPrimitives of the tab ComPrimitive of the Configurator of an HMI Control.

<table>
<thead>
<tr>
<th>ComPrimitive</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>GotoOnline</td>
<td>changes the state of a LogicalLink from offline to online without communication</td>
</tr>
<tr>
<td>GotoOffline</td>
<td>changes the state of a LogicalLink from online to offline without communication</td>
</tr>
<tr>
<td>StartCommunication</td>
<td>performs Protocol specific initialization</td>
</tr>
<tr>
<td>StopCommunication</td>
<td>performs Protocol specific termination</td>
</tr>
<tr>
<td>Delay</td>
<td>inserts a delay between a previous and the next ComPrimitive at the execution point of the queue. The value of the delay can be determine by the tab Configuration of the Configurator</td>
</tr>
<tr>
<td>VariantIdentification</td>
<td>performs a Variant identification</td>
</tr>
<tr>
<td>VariantIdentification AndSelection</td>
<td>performs a Variant identification and selects the detected Variant automatically</td>
</tr>
<tr>
<td>ProtocolParameterSet</td>
<td>provides the set of ProtocolParameters defined in the database for the Location</td>
</tr>
<tr>
<td>HexService</td>
<td>allows creating a diagnostic message for sending to an ECU. The ServiceID is the first byte of the PDU</td>
</tr>
<tr>
<td>RawService</td>
<td>allows creating a bytestream for sending to an ECU (only used with K-Line)</td>
</tr>
<tr>
<td>SelectUploadContainer</td>
<td>selection of an upload container file for flash activities</td>
</tr>
<tr>
<td>SelectDownloadContainer</td>
<td>selection of a download container file for flash act</td>
</tr>
</tbody>
</table>

5.3.4.3 How to create a Sequence

In this chapter the creation of a Sequence is described.

- Step 1: Select the tabs **Sequence 1**
- Step 2: Select the appropriate DiagnosticServices and ComPrimitives in the tabs **Services** and **ComPrimitives** and add them by the button with the left arrow to the list of the tab **Sequence 1**.
5.3. Common Configuration Options

- Step 3:
  If necessary change the order of the Services/ComPrimitives by the buttons with the up and down arrow or remove Services/ComPrimitives by the button with the right arrow.

The figure below shows an example of a Sequence.

5.3.4.4 Configuration of ProtocolParameters

Some HMI Controls (e.g. DiagnosticService, and SoftKey) provides the possibility to configure ProtocolParameters. ProtocolParameters describe the boundary conditions which are used for the communication which a user might want to change if necessary.

The possibility to configure ProtocolParameters is provided by the run time ComPrimitive ProtocolParameterSet. Consequently the Configuration of ProtocolParameters becomes not active until executing this ComPrimitive by a Sequence of the appropriate HMIcontrols in Execution Mode of DTS 8 Monaco.

- Step 1:
  Select the tab **Sequence1** and afterwards the tab **ComPrimitives**.

- Step 2:
  Add the ComPrimitive ProtocolParameterSet to the Sequence’s list (see chapter How to create a Sequence).

- Step 3:
  Select the ComPrimitive ProtocolParameterSet in the list box of the tab **Sequence1** by a left mouse click and activate the tab **Configuration**.

- Step 4:
  In this case the tab **Configuration** provides all ProtocolParameters and their current
values (see Figure below). After a double left click on the ProtocolParameter, whose value should be changed, the corresponding field of the column Value is activated. Now it is possible to change the value in two ways. The first way of changing is by a pull down menu. By this pull down menu the value can be changed. The second possibility is that the corresponding field of the column Value becomes active and the user is able to change the value by entering the new value. The unit of a value can not be changed.

• **Step 5:**
  Confirm each entry by ENTER.

### 5.3.5 Configuration of Diagnostic Services

This chapter deals with the relationships between the tabs Services, ComPrimitives and Configuration of the Configurator of an HMI Control. As in the chapters before the HMI Control DiagnosticServices in combination with the DTSP project tutorial is used as an example for the concrete description.

#### 5.3.5.1 Structure

The tab Configuration is only activated if a DiagnosticService in the tab Services or a ComPrimitive in the tab ComPrimitives is selected. In this case the tab Configuration displays the Properties of the selected item. The content of the tab relates to the selected entry.

The figure below provides the structure of the tab Configuration. The DiagnosticService readDataByCommonID is used as an example here. The tab Configuration consists of a list box which is divided into three columns. The first column Params & Responses
5.3. Common Configuration Options

consists of four Property groups. The second column Value provides the corresponding values of the Properties of each Property group. And last but not least the third column Unit display the unit (if available) of each Property.

• Property group Params
  The Property group Params consists of all ServiceParameters of the Request of the DiagnosticService selected in the tab Services, which are available by the appropriate Venice database. The values of these Properties are changeable. But there is one exception. If the ServiceParameter is a ConstantParameter it is not possible to change the value.

• Property group Symbolic Responses
  The Property group Symbolic Responses contains all Service Parameters which are necessary to interpret the Response of the selected DiagnosticService in a symbolic way. There are check boxes in front of each Property. If a checkbox is activated (i.e. has a check mark) the Property is visible in the user interface of the HMI Control (e.g. in the list box Process Values of the HMI Control DiagnosticServices). As a default all Properties of the Symbolic Responses are activated (visible).

• Property group Response Classes
  The Property group is called Response Classes. This group has two Properties, PDUs and All symbolic Responses. If the first Property PDUs is checked (default) the PDU of the Request and the Response of the selected DiagnosticService is shown e.g. in the list box Process Values of the user interface of the HMI Control DiagnosticServices. If the Property All symbolic Responses is activated all Properties of this Property Group are visible e.g. in the list box Process Values of the user interface of the HMI Control DiagnosticServices. The Properties of this group have no corresponding value.
5.3. Common Configuration Options

- **Property group Execution**
The Property group is called Execution. The property with the name *generic*. When this property is checked the execution of the appropriate DiagnosticService is not fixed to a specific LogicalLink. Thus sequence buttons are reusable for different LogicalLinks, but the used DiagnosticService must be implemented in the different LogicalLinks. Which LogicalLink shall be used is determined in the user interface during execution mode. The sequence button will be executed on the LogicalLink, which is selected in the listbox Database.

With help of the property *skip* an element of the sequence can be skipped during execution. So the user can disable an element of a sequence without deleting it definite.

For detailed information about DiagnosticServices and ServiceParameters please have a look into the manual of DTS-Venice.

5.3.5.2 How to change the Configuration of a DiagnosticService

Changing the Configuration of a DiagnosticService is described in this chapter. As an example the DiagnosticService readStatusOfDTC is used. If you want to change the Properties of the Property group Params, i.e. the ServiceParameter of the Request of the Diagnostic-Service perform the following steps.

- Step 1:
  Select the appropriate Property by a double left mouse click.

- Step 2:
  Now two ways of changing the value are possible:
  The first one is the occurrence of a pull down menu (see Figure below) in the corresponding line of column Value. By this menu the user is able to select another value for the chosen Property. If the value is from type Boolean automatically the value will be toggled. The second one is the activation of the corresponding line of the column Value. Afterwards the user can enter the new value.

- Step 3:
  Confirm your entry by ENTER.
There are two possibilities to change the visibility of a Property of the group Symbolic Responses:

- The first one is to uncheck (left mouse click on the check mark) the Property All Symbolic Responses of the Property group Response Classes. Afterwards all Properties of the group Symbolic Responses are unchecked automatically. Now the user can activate the visibility of each Property of this group on his own.

- The second possibility is just to uncheck the Properties of the Property group Symbolic Responses.

### Configuration Tab

<table>
<thead>
<tr>
<th>PROPERTY GROUP / PROPERTY</th>
<th>VALUES</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Params/SID_RQ</td>
<td>value from the database</td>
<td>Service Identifier</td>
</tr>
<tr>
<td>Params/RecordDataIdentifier</td>
<td>value from the database</td>
<td>Record Data Identifier</td>
</tr>
<tr>
<td>SymbolicResponses</td>
<td>-</td>
<td></td>
</tr>
<tr>
<td>Response Classes</td>
<td>-</td>
<td></td>
</tr>
<tr>
<td>Execution/executeOnActiveVariant</td>
<td>-</td>
<td>If this option is active the appropriate service is executed on the currently active Ecu Variant of the ECU.</td>
</tr>
</tbody>
</table>
5.4 Setting the ECU Sequence Order

HMI Controls that have a Sequence Editor, e.g. Complete Vehicle Coding make use of the ECU Sequence Order defined by this Configurator.

This configurator is able to determine the order of the ECUs in which they are handled in sequences.

Opens the ECU Sequence Order Configurator by selecting Configure ECU sequence order... from the Tools menu. This item is only available in Configuration Mode.

This configurator is able to determine the order of the ECUs in which they are handled in sequences.
5.4. Setting the ECU Sequence Order

The sequence is built of four main groups that are executed one after the other:

- **PreSequence**: ECUs in this group are handled serially.
- **MainSequence**: ECUs in this group are handled in parallel.
- **PostSequence**: ECUs in this group are handled serially.
- **NotHandled**: ECUs in this group are not handled.

The order of the ECUs in the Configurator may be changed by DragDrop of items in the list.

- **Serial Group**:
  Serial processing in this group in enforced.
  A serial group may be useful when you want a set of ECUs to be processed one after the other, while the rest is processed simultaneously.

To create a new serial group select an ECU and select *create Serial group with selected ECU* from the context menu, alternatively you may use the shortcut CTRL+N.
Enter a name for the new Serial Group. You may change this name later by selecting Rename Serial Group (F2) from the context menu.

To delete a Serial Group move all ECUs to another location using drag and drop. An empty Serial Group may be removed using the context menu entry Delete Serial Group (DEL).

- **Alternative Group:**
  This is a special use case for a Serial Group. This group type may be used in all main nodes. In this case the Serial Group is processed differently.

  An Alternative Group typically contains ECUs of the same type (which typically have the same CAN Identifier). Only one of these ECUs usually is present in a vehicle. For example an Alternative group may contain different Motor ECUs. But only one of these Motor ECUs is installed in the vehicle.

  In the HMI Controls SWT Quicktest and Complete Vehicle Coding the ECUs from an Alternative Group are handled as they appear in the sequence. For each ECU a Variant Identification is performed. In case a Variant is identified successfully this Variant will be processed and after that the processing of the Alternative Group will be finished without handling the other ECUs. If no Variant was identified, the first ECU in this group will be processed as Base Variant.

  To create an Alternative Group create a Serial Group first and then tag it as Alternative Group using the context menu of the group item.

  An Alternative Group may be removed when Untag as Alternative Group is selected from the context menu.

- **Parallel Group:**
  The ECUs of a Parallel Group are processed in parallel.

  How many ECUs are processed at the same time depends on the parameter Maximum LogicalLinks, that may be set in the Configurator of the corresponding HMI Control. The value 1 will result in a serial processing of the ECUs. A value of 2 allows to process 2 ECUs in parallel. If one ECu has been finished the next one will be processed immediately. A Serial Group embedded in a Parallel group will be handled as a single ECU. The parallel group cannot be create but exists Sequence of the ECU sequence order configuration.

  The button Calculate Default Order calculates a sequence that always works:
All CAN ECUs are assigned to the Main Sequence allowing parallel handling, whereas all LIN ECUs are assigned to the Post Sequence where they are treated serially.

6 The Monaco HMI Controls

This chapter describes the functionality and user interfaces of HMI Controls (Human Machine Interface Control). HMI Controls are specialized interfaces for one distinct user task (in the case of DTS e.g. for DTC access, coding of an ECUVariant, flash access, reading measurement values, etc.).

The HMI Controls are grouped as follows:

HMI Controls of type Communication

- Bus Trace
- Diagnostic Services
- Symbolic Trace
- OTX Script Console

HMI Controls of type Control

- Annotation
- Communication Control
- Logical Link List
- Toggle Sequences

HMI Controls of type Function

- ECU Identification
- DTC
- IO Control
- Flash
- OBD
- Soft Key

HMI Controls of type Measurement
• Data Display
• Recorder
• Graphical Instrument

Daimler specific HMI Controls
• Tool Quick Test
• Variant Coding
• Complete Vehicle Coding
• VRX Differ
• ECU Exchange